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Important Precautions and Safety Information

When using this product, these basic safety precautions should always be followed
to reduce risk of fire, electric shock, and injury to persons:

1 Read and understand all instructions.
2 Use common sense whenever operating electrical appliances.

3 Follow all warnings and instructions marked on the product and in the literature
accompanying the product.

4 If an operating instruction appears to conflict with safety information, heed the
safety information. You may have misunderstood the operating instruction. If
you cannot resolve the conflict, contact your sales or service representative for
assistance.

5 Unplug the product from the AC wall socket and/or telephone jack before
cleaning. Do not use liquid or aerosol cleaners. Use only a damp cloth for

cleaning.

6 Do not place the product on an unstable cart, stand, or table. It may fall,
causing serious damage.

7 Your product should never be placed on, near, or over a radiator, heater, air
conditioner, or ventilation duct.

8 Do not allow anything to rest on the power. Do not locate your product where
the cords will be abused by persons walking on them.

9 Do not overload wall outlets and extension cords. This can diminish
performance, and may result in the risk of fire or electric shock.

10 Do not allow pets to chew on the AC power, telephone, or PC interface cords.

11 Never push objects of any kind into the product through case or cabinet
openings. They may touch dangerous voltage points, creating a risk of fire or
shock. Never spill liquid of any kind onto or into the product.
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12 Your product may have a heavy cover for optimal pressure on the document for
the best scanning and/or faxing (usually the flatbed-type product). In this case,
replace the cover after placing document on the scan glass, by holding and
moving it down slowly until it seats on its location.

13 To reduce the risk of electric shock, do not disassemble the product. Take it to a
qualified service technician when repair work is required. Opening or removing
covers may expose you to dangerous voltages or other risks. Incorrect
reassembly could cause electric shock when the unit is subsequently used.

14 Unplug the product from the telephone jack, PC and AC wall outlet, and refer
servicing to qualified service personnel under the following conditions:

e When any part of the power cord, plug, or connecting cable is damaged or
frayed.

o If liquid has been spilled into the product.

o If the product has been exposed to rain or water.

o If the product does not operate properly after instructions have been followed.
¢ If the product has been dropped, or the cabinet appears damaged.

¢ If the product exhibits a sudden and distinct change in performance.

15 Adjust only those controls covered by the operating instructions. Improper
adjustment of other controls may result in damage, and may require extensive
work by a qualified service technician to restore the product to normal
operation.

16 Avoid using this product during a lightning storm. There may be a remote risk of
electric shock from lightning. If possible, unplug the AC power and telephone

cord for the duration of the lightning storm.

17 SAVE THESE INSTRUCTIONS.
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SETUP

Thank you for purchasing the Samsung SF-430 InkJet all in
one. This multifunctional product provides printing, copying
and scanning functions!

This chapter provides step-by-step instructions on setting up
the product, and installing the software.

The chapter includes:

e Setting Up Your Product
e Installing Software

e Basic System Setup
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Setting Up Your
Product

Choosing a Location

To help guarantee trouble-free operation of your product,
place it on a flat, stable surface near your workstation. Leave
enough space to allow for easy paper loading, paper out and
opening the top cover.

Do not place your product:

e In direct sunlight.

¢ Near heat sources or air conditioners.

e In dusty or dirty environments.

Unpacking

Unpack your product from the packing box, and check if
anything is missing or damaged. Remove the shipping tapes
from the front, back, and sides of the product.
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Contents

Here is what is supplied with your product.

TAM lead USB cable

Samsung SF-430

User's Guide Samsung SmarThry

Software CD-ROM, SmarThru User’s Guides,
User’s Guides Warranty cards, Quick Install Guide

a.The shape of the cord plug may differ depending on your country.

SETUP m
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Control Locations and Functions

Take a moment to familiarize yourself with the main
components of your product.

Front View

Paper Guide Paper Input Support

Document Guide

Handset

Paper Bin

Document
Input Support

Document
Output Support
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Inside

Top Cover

Print cartridge
holder

Front Panel

Connector
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AC Power Socket

LINE Jack Parallel Connector

EXT Jack

If your country has a different
telephone connection system,
this socket may be blocked.

SETUP m
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Front Panel Button Functions

Cancel/Reset

Color Inkjet All in One  SF-430

Displays current status and prompt during
operation.

Setup

Enters menu mode.

Enter

O

Confirms the selection on the display.

Cancels a current operation including PC
printing or resets the copy and fax setting
item (Quality, Copy Page, Zoom Rate,
Resolution, or Contrast) to its default setting.

Allows you to save ink by up to a maximum of
50% by printing images lighter (available in
PC print, Copy and Fax receiving mode).

Paper

Allows you to save paper by printing 2 pages
on a single sheet of paper (available in Black
and White Fax receiving and Copy mode only).

Toll

o

Allows you to save on faxing costs by sending
a fax at a preset time. By using this feature,
you can take advantage of lower long distance
rates at night, for example (only available in
fax sending).

Scan to

1 O

Launches Samsung ScanWizard in the desktop
window from which you can select the scan
destination.
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Quality

O

Adjusts the copy quality.

Copy
Page

Selects the number of copies.

Zoom
Rate

Makes a copy smaller or larger than the
original.

Black

O

Makes a black and white copy.

Color

9

Makes a colour copy.

1 10

Stores frequently dialled fax numbers and

ON©) dials them with a touch of the buttons.
sw: | Dials @ number or enter alphanumeric
@”@ characters.

Receive Mode

Selects the receive mode. The selected mode
is displayed in Standby mode.

Searches for a number in memory. Also use to
delete digits in the edit mode.

Adjusts the resolution of the documents for
the current fax job.

Adjusts the contrast of the documents for the
current fax or copy job.

Redials the last number you dialled or
received, and inserts a pause into a fax
number.

Scroll/Volume

Scrolls through the menu items. Also used to
adjust the volume.

OHD/V.Req

Engages the telephone line. Also used to
reserve a voice call during fax transmission or
reception.

FAX Forward

Sets your product to forward incoming faxes
to another fax number.

S

Speed

Stores frequently dialled fax numbers and dial
them using a 2-digit speed number.

Black

O

Starts to send a black and white fax.

Color

O

Starts to send a colour fax.

SETUP m
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Setting Up Your product

Document Input Support

Pull the document input support upward. Fold out the
extender, if necessary.

Document Output Support

Insert the two tabs on the document output support tray into
the slots on the front of your product. Fold out the extender,
if necessary.

Extender

Document output support

Handset

Plug the end of the handset line into the jack at the bottom
of the product, and fix the line into the latch.
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Telephone Line

Plug one end of the supplied telephone line cord into the
LINE jack socket and the other end into a standard phone
wall jack socket.

N

R33N
338se
NIN
I
o5

To phone wall jack :J

NOTES:

e This product is intended for connection to analogue telephone
networks in the United Kingdom.

e It is strongly recommended that you use the TAM lead and
telephone line cord supplied with your machine.

e If you are using the line cord with the other manufacturer’s,

it should be AWG #26 or lower gauge. Note that the product
may not operate correctly.

Extension Phone

If you want to use a regular phone or answering machine
with your product, connect the phone into the EXT jack.

Plug the cord of your extension phone or answering machine
into the TAM lead and the TAM lead into the socket marked
EXT on the back of your product.

}Q TAM lead (applicable only in UK)

>

SETUP m
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Printer Cable

Connect the printer cable into the connector on the back of
the product. Then, connect the other end of the cable to the
corresponding port on your computer.

Use either USB cable which come with your product or IEEE-
1284 compliant parallel cable (purchased separately).

W USB cable™~_"

To
computer« SE E

Parallel cable

NOTES:
o If using a USB cable, you must be running Windows 98/Me/
2000/XP.

¢ Shut down your computer before connecting the cable.

¢ When using USB connection, your product provides two USB
modes: Fast and Slow. Fast is the default mode. Some PC
user may experience poor USB implementation in the default
mode. If this occurs, select Slow mode to achieve successful
results. For details on changing the USB mode, see page
7.14.

AC Power Cord

Plug one end of the cord into the back of the product and the
other end into a standard grounded AC power outlet.

To AC outlet

-
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As you plug it in, your product will turn on. ‘POWERING UP
PLEASE WAIT' appears on the display indicating the product
is on. To view your display text in another language, see page
1.40.

If you want to turn it off, unplug the power cord.

NOTE: When you first set up the product, you see "CHECK
CARTRIDGES” on the display. Load paper (see page 1.11), then
install the print cartridges (see page 1.13).

Loading Paper

The display shows "ADD PAPER THEN PRESS ENTER” if no
paper is loaded starting to print a job. The paper bin will hold
approximately 100 sheets of 20 Ib plain paper.

In the Fax or Copy mode, you can use A4-, letter-, or legal-
size paper.

To load plain paper, take the following steps:

1 Pull the paper support on the paper bin all the way up.

Paper support

SETUP m
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2 Fan the paper and then insert it into the paper bin with
the print side facing you. Ensure that the right edge of
the paper is in contact with the right side of the paper
bin. Do not exceed the specified capacity.

3 Squeeze the paper guide and move it to the right to
match the width of the paper.

Paper guide

4 Ppull the output tray and the output tray extender on the
front of the product all the way out.
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NOTE:
¢ Do not force the paper down into the printer.

¢ To ensure proper paper feeding, it is recommended that you load
a stack of paper (more than 20 sheets).

o If you are using legal-size paper, & 5
do not pull the output tray out.
Push it in, or it may cause a
paper jam when the paper prints
out.

o After loading paper, you have to set your product for the
paper size you have used. For details, see page 3.2 for copy
job, page 5.39 for fax job and page 2.10 for PC printing job.

Installing the Print Cartridges

Your product comes with a black and a colour cartridge. You
can purchase an optional photo cartridge and install it instead
of the black cartridge. See page 1.18 for the options you can
purchase.

Use this procedure when installing print cartridges for the
first time. To install replacement print cartridges, see
“Replacing the Print Cartridges” on page 6.10.

NOTE: There are two types of black and colour cartridges:

Standard and high yield. Before proceeding to install, you need
to check which cartridge type you have. When installing the
cartridges, you will be asked if it is Standard or High Yield. To
find out the type, please refer to the table on page 6.10.

SETUP @
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1 Unwrap and remove the black print cartridge from the
plastic bag. Hold the print cartridge at the top. Do not
touch the electrical contacts.

Carefully remove the sealing tape covering the print
head.

2 Lift the front panel by grabbing the panel along the top
edge and pulling it towards you.
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4 The cartridge holder moves to the install position.

The colour cartridge will be inserted into the left side of
the cartridge holder and can be identified by a yellow
tab on the top of the holder.

The black (or photo) cartridge will be inserted into the
right side of the cartridge holder and can be identified
by a green tab on the top of the holder.

Yellow tab indicates
colour cartridge
position.

Green tab indicates
black or photo
cartridge position.

5 Insert the black print cartridge into the right side of the
holder.

Black ink cartridge
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7 Unwrap and remove the colour print cartridge from the
plastic bag. Holding the cartridge at the top, carefully
remove the sealing tape.

8 Insert the colour print cartridge from the print head into
the left side of the holder.

place.

10 After installing the print cartridges, close the cover and
replace the front panel.

NoOTES: If the display shows "REMOVE PAPER JAM AND PRESS
CANCEL"” when you have closed the front panel, re-install the
cartridge(s). With the print cartridge(s) installed improperly,
the product might not print.

11 When you have closed the covers, the display prompts
you to confirm ‘CARTRIDGE CHANGED? NO'. Press the
Scroll buttons ( ¢ or p ) until you see ‘BOTH’ in the
bottom right corner of the display and then press Enter.
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12 The display shows 'LEFT CARTRIDGE NEW COLOR'. Press
Enter to confirm you have installed a new colour
cartridge.

13 The display shows ‘LEFT CARTRIDGE STANDARD
COLOR'. Press Enter to confirm you have installed a
standard capacity cartridge. If not, press the Scroll
buttons ( «q or p ) to display ‘LEFT CARTRIDGE HIGH
YIELD COLOR’ and then press Enter.

14 The display shows ‘RIGHT CARTRIDGE NEW BLACK".
Press Enter to confirm you have installed a new black
cartridge.

15 The display shows ‘RIGHT CARTRIDGE STANDARD
BLACK'. Press Enter to confirm you have installed a
standard capacity cartridge. If not, press the Scroll
buttons ( «q@ or p ) to display ‘RIGHT CARTRIDGE
HIGH YIELD BLACK' and then press Enter.

16 The cartridge holder returns to the home position. The
Cartridge Alignment procedure begins automatically by
printing an Alignment Test Form.

Use this test form to identify the straightest line in each
of six alignment areas. By selecting the straightest line
for each pattern, you will optimise the print head
alignment.

CARTRIDGE ALIGNMENT

ALIGNMENT A

0 345678 91010IMISI61718192021 2223 242526272829 30

17 Looking at your Alignment Test Form, identify the
straightest line in Alignment A.

Using the number keypad, enter the two digit number of
your straightest line and then press Enter.

SETUP m
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18 The display accepts your number and moves to
alignment B. Repeat step 16 for alignment patterns B-F.

CARTRIDGE MAINT.
gTr  [B-281 A

Number Range
Last Alignment Alignments
Entry (A,B,C,D,E F)

19 When you finish entering the number for alignment
pattern F, the display returns to Standby mode.

g NOTES:

o When either print cartridge starts to run out of ink, replace the
empty print cartridge. With an empty print cartridge or only one
print cartridge installed, the product will print but the print
quality will be reduced.

o Keep a spare print cartridge on hand. When buying print
cartridges, check the part numbers referenced below to ensure
buying the correct print cartridge. These print cartridges have
been specifically designed to work with your product to produce
results that are always clear and sharp.

o If you want to purchase a new print cartridge, either contact
your point of purchase or any Lexmark authorized supplies
dealer.

Cartridge type Part number

High yield Lexmark 12A1975

Black cartridge Standard Samsung INK-M50
andar Lexmark 12A1970

High yield Lexmark 15M0125

Colour cartridge Samsung INK-C60
Standard Lexmark 15M0120
Photo cartridge Lexmark 12A1990
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Installing Software

About Samsung Software

You must install the SmarThru CD-ROM after you have set up
your product and connected it to your computer. The
SmarThru CD-ROM includes the following:

e MFP Driver
e SmarThru Software
¢ OCR Software (AnyPage Lite)

MFP Driver

To use your SF-430 as a printer and scanner, you must install
the MFP driver.

SmarThru Software

SmarThru is the accompanying software for your SF-430
multifunctional product. SmarThru contains a powerful image
editor that allows you to edit images in many ways and also
includes powerful Internet mail client software. With
SmarThru, you can save the scanned images in a dedicated
storage area for subsequent editing, sending via e-mail or
fax, printing, and processing by other programs of your
choice.

OCR Software (AnyPage Lite)

OCR (Optical Character Recognition) is software that has the
ability to recognize most character formats, so that a
scanned document can be read and edited with word
processing software.

SETUP m
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System Requirements

Before you begin, ensure your system meets these minimum
requirements.

Supported Operating System

Windows 95 OSR2/Windows 98/Windows 98 SE/Windows
Me/Windows NT 4.0 Workstation or Server with Service Pack
3/Windows 2000 Professional or Advanced Server/Windows
XP Home edition or Professional.

Minimal Requirements

o Disk space: 130 MB for installation
e Memory: 64 MB

e CPU: Pentium II 233 or higher

¢ Required software: Internet Explorer 4.01 or later.

Recommended

o Disk space: 250 MB for installation
e Memory: 128 MB

e CPU: Pentium II 400 or higher

¢ Required software: Internet Explorer 5.5 or later

g Nores:

¢ Administrative rights should be set for installation on Windows
NT 4.0/2000/XP.

e Windows 95 versions prior to OSR2 are not recommended
due to compatibility with OLE/COM libraries.
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Installing Samsung Software

NOTESs:

o For Windows 95/98/Me/2000/XP users, cancel the "New
Hardware Found” screen when the computer boots up.

e Make sure that your SF-430 is plugged in and connected to
your computer’s USB or parallel port before installing
software from the CD. Windows 95 and Windows NT 4.0 do
not support USB connection.

1 Insert the supplied SmarThru CD-ROM into your CD-
ROM drive.

The SmarThru CD-ROM should automatically run and
the opening window appears.

If the opening window does not appear, click Start, and
then Run. Type X:Autorun, replacing “"X” with the
letter of your drive, and click OK.

If you are asked to select the language, choose the
desired language.

2 Click Install the Samsung Software on your PC.

Installs the
| Samsung

Install ¢
g Software on
S

LY l ”~ the Samsung
- — Software on your PC.

your PC.

SAMSUNG Software
Installation .
Uninstall
the Samsung
Software on your PC.

Uninstalls the
| Samsung
Software.
See page
1.29.

Io 00—

SAMSUNG DIGITal

.................

3 After reading, click Next.

SETUP m
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4 Follow the on-screen instructions and click Next.

5 The SmarThru installation supports three types of
setup:

sTypical: Program will be installed with the most
common options and is recommended for most users.

sCompact: Only the MFP driver will be installed.

eCustom: You may choose the options you want to
install. Recommended for advanced users.

Setup Type

Click the type of Setup you prefer. then click MNest.

Pragram will be inztalled with the most common
optiohs. Recommended for most users.

" Compact  Program will be installed with minimurn required
options.

Lo Customn *t'ou may chooze the aptions you want to install.
( Recommended for advanced users.

< Back I Hext > I Cancel

If you select the Custom installation, you may choose
the options you want to install.

Select Components [ %]
Select the companents you want ta install, clear the components
you do not want to install

LComponents

OCR Software BET20 K
MFP Driver B416 K
Description

This component includes all SmarThru
services including Intemet Mail, Fax, Image

operation support,

Space Required: 135648 K
Space Available: FIS4BTE K
< Back | Mest > | Cancel |

* SmarThru Software: to scan and edit images
and work with electronic documents.

* OCR Software: AnyPage Lite software to enable
OCR.

o MFP Driver: to print and scan.

6 Click Next.
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7 You can choose the SmarThru networking option. This
feature allows you to share the modems on your
computer and the scan device SF-430 via a network or
to access these shared devices located on other
computers.

Stand-alone configuration does not allow you to use any
networking features such as Remote Fax or Remote
Scan service.

Metwork Configuration [ x|

Please. choose if you will work with SmarT hu locally or will use
itz network. capabilities

Select this option if pou intend to uge SmarT hru onlp with local
devices attached to your computer.

" SmarThiu networking

Select thiz aption if pou want ta share pour modems and scanners
via network or to access these shared devices located on ather
campters.

E
9

< Back I Nest » I Cancel |

If you selected SmarThru networking, you can select
to install server, client, or both.

Metwork Components

Please, chooze which of SmarThru network components you
would like to install
W Server
Select this option if vou intend ta share vour modems and
scanners acoss hetwork.

v .
[V Cliznt
Select this option if you wish ta access modems and scanners
lozated on other computers in your network.

< Back I Hext > I Cancel |

Server allows you to share a local fax modem and/or
scanner over a LAN. You can control sharing by
managing remote service users. Client allows you to
use Remote Fax or Remote Scan services provided by a
SmarThru Remote Services Server over a LAN. You need
to have a client account. These accounts are provided
by the server. For details on Remote Fax/Scan Services,
please refer to the SmarThru User’s Guide.

SETUP @

Download from Www.Somanuals.com. All Manuals Search And Download.



8 Click Next.

Select Program Folder E

Setup will add pragram icons to the Program Folder izted belaw.
“r'ou may twpe a new folder name, or zelect one from the existing
Folders list. Click Mext to continue.

PFrogram Falders:

America Online
HF DeskJet 830C Series +11.1
Internet Explorer

Onling Services

Samszung ML-520008

Samsung SFR100P

Startlp

W 3Pro 2000 Deluxe

< Back I Mest = I Cancel |

9 When the installation is completed, shut down and
restart your computer.

If your computer does not shut down and restart
automatically, you must shut it down manually and
restart it before the changes will be effective.

NOTE: When you install the software, the Digital Signature Not
Found window may appear in Windows 2000 and Windows XP.
Click OK in Windows 2000 and click Continue Anyway in
Windows XP.
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Configuring the Fax Gate and
Internet Gates

If you select SmarThru networking Server option (see
page 1.23), when your computer restarts after the Samsung
software has installed, you will be prompted to configure the
fax and Internet gates allowing you to send and receive faxes
and e-mails on the SmarThru system.

If you select the Stand-alone or SmarThru networking
Client option (see page 1.23), the following wizards appear
only the first time you try to launch Mailbox in the SmarThru
program. For information on SmarThru, please refer to the
SmarThru User’s Guide.)

NOTE: To configure the Internet gate, you must enter your e-
mail address, incoming (POP3 or IMAP4) and outgoing (SMTP)
mail server address, and account name. Ask your Internet
service provider or on-line service provider for the information
on your Internet gate configuration.

1 When the New Modem Wizard appears, choose the
modem installed in your system and then click Next.
This fax modem will be used by SmarThru Fax Gate for
sending and/or receiving faxes.

2 TR e BT T

~New

AR ¥ ol g ST
RS TRNL TaRE  a

Choose system modem to be used

Chooge one among modems installed in your spstem. Thiz fax modem will be
uzed by SmarThru Fax Gate for 2ending and/or receiving faxes.

To edit modem properties or to install new modem press "'System modems..."
buttan.

Samsung GPRS MODEM =l

System modems... |

< Back I Mext » I Cancel

2 Click Finish to save the modem setting.

SETUP E
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3 Enter your name and e-mail address, and click Next.
The e-mail address has been assigned to you by your
Internet service provider.

|

Internet E-Mail Address

Enter your name: IburiliMe

Far example: John A Smith

Enter your e-mail address: I

For example: mailboxiScompany. com

Mote: Y'our e-mail addrezs iz the address ather people uze to zend e-mail messages to pou. This
address has been aszigned to pou by vour Internet service provider.

4 Enter the addresses of your incoming and outgoing mail
servers. Choose the incoming mail server type, then
click Next. Your Internet service provider will be able to
provide you with this information.

|

- New Mail Account Wizard

E-Mail Server Addresses

Type the addresses of your incoming and outgoing mail servers.

Incaoming [POP3 or IMAP4] mail server address: I

Far example; company. com

Dutgoing [SMTP) mail server address: ||

Inhcoming mail server protocal bype: IF'D F3 'l

Far example: company. cam

< Back | TRt I Cancel |
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5 Enter your account name and password to access your
Internet mail server, and click Next. Your Internet
service provider will be able to provide you with this
information.

bruce339

6 Enter an account name, and click Next.

SmarThru

chollian

[ <ok JUWewr T caed |

SV 1.27
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7 Click Finish to quit the wizard and enable the Internet
e-mail service.

g NOTE: If you wish, you can reconfigure the Internet gate later
by using SmarThru Configuration. For details, refer to the
SmarThru User’s Guide.
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Uninstalling Samsung Software

Uninstall is required if you are upgrading the software or if
your installation fails. You can uninstall all software including
SmarThru and MFP drivers using the SmarThru CD or
selectively uninstall the desired item using the Window
unInstallShield.

NOTE: Before beginning uninstallation, ensure all applications
are closed on your PC. A system reboot is required after the
software is uninstalled.

Uninstalling the MFP Driver

1 Start Windows if not already started.

2 From the Start menu, select Programs, then select
Samsung SF-430 Series.

[i_l Favorites » S Epson 4
@HP Desklet 830C Series v11.1 ¥
@ Documents 4 @ Internet E xplorer 4
@ Online Services L4
@ Seftings ¥ [ 5amsung SC%-1100 Series 4
_ @ Samsung SCx-1150 Senies L4
% (e g E Samzung SF-430 Series L4 %Fax Settings Ltility
@ Help @StartUp L4 @Printer Contral Program
- @Xerox workCentre Pro 412 L4 @ Frinter Driver ReadMe
. #3-D0S Prompt (5 5F-430 Series Uninstall

3] windows Explorer

4 TWAIN Driver Help
57 TWAIN Driver Uninstaller

o]

% Ls

=

_§ & Log OFff Buriris. ..

[!ﬁ Shut Daown
A In case of Windows 98

3 You can select the component in the MFP driver to
uninstall individually.

To uninstall the scan driver, select TWAIN Driver
Uninstaller.

To uninstall the printer driver, select SF-430 Series
Uninstall. Restarting your computer will be required.

SETUP m
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4 When your computer confirms your selection, click Yes.

The selected printer driver and all its components are
removed from your computer.

Remove Programs From Your Computer

unlnztallS hield will remaove the software 'S amsung SF-430
Serniez Drivers' from your computer. Pleaze wait while each
of the following components is removed...

Shared program files. ..

Standard program files...

Folder items...

Program folders...

=% "% N

Program directaories. ..

Frogram registy entries...

5 When uninstallation is finished, click OK.

6 The message box recommends you restart your
computer. Click OK, and restart Windows.

NOTE: If you want to install the printer driver or the scan
driver using the SmarThru CD-ROM, make sure that you select
the Setup Type to Compact. Or select Custom then select
MFP Driver. For details, see page 1.22.

Uninstalling Samsung SmarThru
1 Start Windows if not already started.
2 From the Start menu, select Programs.

3 Select Samsung SmarThru, then select SmarThru 3
Uninstall.

Download from Www.Somanuals.com. All Manuals Search And Download.



4 When your computer asks you to confirm your selection,
click Yes. The Uninstall Options dialogue box appears.

-\"". Samsung SmarThru - Uninstall Options E

*f'ou are going to uninstall SmarT hru. Mow pou should decide what you would
like to do with messages, address book information and ather portions of your
working environment.

" Delete

" Leave intact

Description

*f'our messages and configuration options will be zaved and then
deleted. “'ou will be able to restare your cumrent working
environment aftenwards.

< Back I Mest » I Cancel Help

Uninstall options are:
eBackup and delete: Backs up all your data and

options to a safe place. Then removes the SmarThru
system including the data.

eDelete: Deletes all the SmarThru data and options. No
backup or copying takes place. Be careful while using
this option as you can easily lose your data.

eLeave intact: Uninstalls SmarThru software leaving
data and options intact. This can be useful, if, for
example, you decide to install Stand Alone
configuration over SmarThru Networking. In this case,
uninstall Samsung SmarThru having Leave intact
option set and install SmarThru Stand Alone
configuration.

5 After selecting the uninstall option, click Next.

SETUP E
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6 Follow the on-screen instructions to complete the un-
installation. The SmarThru software and all components
will be removed.

Remove Programs From Your Computer

unlnstallShield will remove the software "SmarT hru
Applications’ from your computer. Flease wait while each of
the following components is remaved. ..

Shared program files. ..

Standard pragram files..

Folder items...

Program falders...

Program directories...

S S

Frogram reqistry entries...

Uninztall successfully completed.

7 When uninstalling is finished, click OK. The message
box recommends restarting your computer.

8 Click OK.

9 Shut down and restart your computer to complete the
uninstallation process and save your changes.
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Using the SmarThru CD-ROM

You can uninstall both the MFP driver and the SmarThru
software with the CD-ROM you used to install the software.

1 Insert the SmarThru CD-ROM into your CD-ROM drive.

The SmarThru CD-ROM should automatically run and
the opening window appear. (If the opening window
does not appear, select Run from the Start menu, then
type X:Autorun, replacing “"X” with the letter of your
drive and click OK.

2 Click Uninstall the Samsung software on your PC.

Install
Y l ” the Samsung
- — Software on your PC.
SAMSUNG Softwara
Installation .
o Uninstall
the Samsung
Software on your PC.
SAMSUNG DIGITal

3 Follow the on-screen instructions to complete
uninstallation.

You must shut down and restart your computer before
any changes you have made will come into affect.

SETUP E
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Basic System Setup

Setting Date and Time

If you are setting up the product for the first time, or if the
product has not been operated for an extended period of time
in power plug off, the LCD display prompts you to set the
current date and time.

The current date and time are shown on the display when the
product is in Standby mode. The time and date are also
printed on all faxes you send.

In Standby mode, you can also access the date and time
setup menu at any time by taking the following steps:

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter. The display shows “FAX NUMBER/NAME" on
the bottom line.

3 Press the Scroll buttons («q or B) until you see “DATE/
TIME”, and then press Enter. The date currently set for
the product is displayed.

Take the following steps to enter your current date and time:

1 A flashing cursor prompts you to enter the date. Use the
number keypad to enter the correct date. You can use
the Scroll buttons (<« or p) to manually move the
cursor to a digit you wish to change.

EMTERE DRTE
18-lg-=2881 D=-HM=%

Use the Europe format D-M-Y (Day-Month-Year). You
can change the date format to the USA mode M-D-Y
(Month-Day-Year). See page 1.36.
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2 Press Enter when the date on the display is correct.

If you enter an invalid number, the product beeps and
does not proceed to the next step. If this happens, just
re-enter the correct number.

3 The display asks you to enter the time. Use the number
keypad to enter the current time using 24-hour format.

ERMTER TIHME
iz:88

You can change the clock mode to 12-hour format (e.g.
13:00 as 01:00 PM). See page 1.36. Use the Scroll
buttons (¢ or ) to select AM or PM in 12-hour mode.

4 Press Enter when the time on the display is correct.

The display automatically returns to Standby mode.

Current date Current time

sa-dor 1% 6@
RS S Frz ax reception mode.

For details, see page 5.14.

SETUP E
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Changing Date Format

Your product displays the current date in Europe format.
Europe format displays the date in a format of Day-Month-
Year. You can change the date format to USA format (Month-
Day-Year).

Take the following steps to change the date format:

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter.

3 Press the Scroll buttons («q or ) until you see “DATE
FORMAT” and then press Enter. The date format
currently set for the product is displayed.

ODRTE FORMAT
ELUROFE 4

4 Press <« or B to select the other format and then press
Enter to save the selection.

Changing Clock Mode

You can configure the product to display time using either a
12 hour or 24 hour format.

Take the following steps to change the date format:

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter.

3 Press the Scroll buttons (< or ) until you see “CLOCK
MODE" and then press Enter. The clock mode currently
set for the product is displayed.

4 Press the Scroll buttons («¢ or ) to select the other
mode and then press Enter to save the selection.
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Setting Fax Number and Name

In some countries you are required by law to indicate your
fax number on any fax you send. Your telephone number and
name (or company name), will be printed at the top of each
page sent from your product.

NOTE: Depending on your country, the Fax Number and Name
setting may be unavailable.

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter. The display shows “FAX NUMBER/NAME" on
the bottom line.

3 Press Enter. If there is a number already set, the
number appears on the bottom line.

ERMTER MUMEER

4 Enter your fax telephone number. You can include the +

symbol in the phone number by pressing the * button
and the - symbol by pressing the # button.

If you make a mistake, move the cursor under the
wrong character by pressing the Scroll buttons (<« or
) and press the correct number. To delete a number,
press Search/Delete.

5 Press Enter when the number on the display is correct.
The display asks you to enter the name.

EMTER HAME

6 Enter your name or company name by using the number
keypad.

For details on how to use the number keypad to enter
alphanumeric characters, see page 1.38.

SETUP ﬂ
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If you want to enter the same letter or number in
succession (e.g. SS, AA, 777), enter one digit, then
move the cursor by pressing the p button, and enter
the next digit.

If you want to insert a space in the name, you can also
use the p button to move the cursor to skip the
position.

7 Press Enter when the name on the display is correct.

The display automatically returns to Standby mode.

Entering Characters Using the Number
Keypad

As you perform various tasks, you'll need to enter names and
numbers. For example, when you set up your product, you
enter your name (or your company’s hame) and telephone
number. When you store one-touch dial, Speed dial or Group
dial numbers, you may also enter a corresponding name.

To enter alphanumeric characters:

1 When prompted to enter a letter, locate the button
labelled with the character you want.

Press the button repeatedly until
the correct letter appears in the

G

display. GHI

5
) CheH

For example, to enter the letter O, fans iy
press 6, (labelled MNO).

Symbols

e
i

Each time you press 6, the display pore
shows a different letter, first M,
then N and O, and finally 6.

You can enter special characters (space, plus sign, etc.).
For details, see “Keypad Character Assignment” on page
1.39.

2 To enter additional letters, repeat step 1.
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If the next letter is printed on the same button, move

the cursor by pressing the p button, then press the
button labelled with the letter you want.

The cursor moves right and the next letter appears in
the display.

3 When you finish entering letters, press Enter.

Keypad Character Assignment

Key | Assigned numbers, letters or characters

1 Space 1
A Cc 2
F 3

B

E
H 1 4
K L5
N O 6
Q
U
X

RS 7
vV 8
Y Z 9
-, ./ x # &0

Ol W W NI | | W N

D
G
J
M
)
T
w
+

Editing Numbers or Names

If you make a mistake, move the cursor under the wrong
character by pressing the Scroll buttons (-« or ) and enter
the correct number. To delete a letter, press Search/Delete.

Inserting a Pause while Entering a Number

With some telephone systems, you must dial an access code
(9 for example) and listen for a second dial tone. In such
cases, you must insert a pause in the telephone number. You
can insert a pause while you are setting up automatic dial
numbers.

To insert a pause, press Redial/Pause at the appropriate
place while entering the telephone number. “P” will appear in
the display at the corresponding location.

SETUP @
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Changing the Display Language

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter.

3 Press <« or P repeatedly until you see “"LANGUAGE”,
and press Enter.

4 Press the Scroll buttons («q or B) repeatedly to select
the desired language.

The following options can be selectable: English,
German, French, Italian, Spanish, Portuguese, or Dutch.

5 Press Enter to save the selection and return to Standby
mode.

Setting the Discard Size

When receiving or copying a document as long as or longer
than the paper loaded in the paper bin, you can set the
product to discard any excess images at the bottom of the
page, to fit on to the paper size in use.

NOTE: If the Auto Reduction feature (page 5.40) is turned ON,
discarding parts of the received faxes does not take place.

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter.

3 Press the Scroll buttons (< or B) repeatedly until you
see "DISCARD SIZE”, and press Enter.
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4 Enter the desired discard size using the number keypad.

Anything within the margin set will be discarded from
received or copied pages.

If the data is outside the margin set, it will be printed on
two sheets of paper at the actual size.

5 Press Enter to save the selection and return to Standby
mode.

Setting Sounds

You can set the following sounds:

¢ Ringer volume: You can adjust the ringer volume. Choose
from HIGH, MED, LOW, or OFF. The OFF setting turns the
ringer off.

¢ Alarm sound : You can turn the alarm sound on or off. If set
to ON, an alarm sounds when an error occurs.

¢ Key sound : You can turn the key tone on or off. If set to
ON, key tone are heard when a key is pressed.

e Speaker volume: You can adjust the volume of the speaker
to desired level.

Ringer Volume, Alarm Sound, Key Sound

1 Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

2 Press Enter.

3 Press the Scroll buttons (<« or B) repeatedly until you
see the desired sound you want to set and then press

Enter.
4 Press the Scroll buttons («¢ or ») until you see and

hear the desired volume setting on the display and then
press Enter to save the selection.

SETUP m
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Adjusting Speaker Volume

1

Press OHD/V.Req. You'll hear a dial tone if the
telephone line is correctly connected to the Line jack.

Press the Scroll buttons (- or ) repeatedly until you
hear the desired loudness. The display shows the
current volume level.

Press OHD/V.Req to save the setting and return to
Standby mode.

Setting Dialling Mode

You can set the type of telephone system your product is
connected to. This setting may be unavailable depending on
your country.

1

Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

Press Enter.

Press the Scroll buttons (- or ) repeatedly until you
see "DIALLING MODE", and press Enter.

Press the Scroll buttons (- or ») repeatedly to select
the desired mode.

Select “"TONE" if the product is connected to a tone dial
line.
Select "PULSE" if the product is connected to a pulse dial
line.

Press Enter to save the selection and return to Standby
mode.
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Setting the PIN Code

You can set the product to require a special PIN (Personal

Identification Number) code when somebody tries to make
colour copy. The PIN code helps you prevent your product
being used by unauthorised persons.

Take the following steps to activate this feature and set the

PIN code:

1 Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

2 Press Enter.

3 Press the Scroll buttons (< or B) repeatedly until you
find "PIN CODE", and press Enter.

4 Press the Scroll buttons («¢ or B) repeatedly to select
“ON”, and press Enter.

If you want to disable the PIN code, select "OFF”. You do
not need to continue the following steps.

5 The display prompts you to enter the PIN code number.
Enter the four-digit code number as your preference
using the number keypad.

The PIN code is preset to "0000” at the factory.

6 Press Enter to save the setting.

You will be required to enter the four-digit code each
time you press the Start Copy Color button.

SETUP m
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Setting the Handset Mode

You can activate the PIN code to restrict the use of the
handset by setting the handset mode to ON. This will block
the outgoing calls from your product by unauthorised
persons.

NOTE: Before enabling this feature, you must enable the PIN
code by restricting colour copy. See page 1.43.

Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

Press Enter.

Press the Scroll buttons (g or ) repeatedly until you
see "HANDSET MODE", and press Enter.

Press the Scroll buttons («q or ») repeatedly to select
the desired setting.

If you want to restrict calls from your product, select
“ON", Otherwise, select “"OFF".

Press Enter to save the selection.

You will be required to enter the four-digit code each
time you lift the handset.
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Setting Paper and Ink Save Modes

Ink Save

The Ink Save feature allows the printer to use less ink on
each page. Activating this mode will extend the life of the ink
cartridge, but will reduce the print quality.

To use Ink Save mode, press SAVE Ink on the front panel. If
the button backlight is on, the Ink Save mode is active and
the printer uses less ink when printing from PC, receiving
faxes and printing copy pages.

If the button backlight is off, the Ink Save mode is disabled
and you will print in a normal quality.

Paper Save

This feature allows you to print 2 pages on a single sheet of
paper saving paper. This mode is available only in black and
white copy or fax modes.

1 Press SAVE Paper on the front panel.

2 Press the Scroll buttons (<« or ») repeatedly until you
find the desired setting.

Select "ON” to activate the Paper Save mode.
Select "OFF” to deactivate the Paper Save mode.

3 Press Enter to save the selection and return to Standby
mode.

NOTE: The Paper Save feature may not work when copying or
receiving long documents (for example, legal size) because
Auto Reduction cannot be achieved.
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PRINT

Read this chapter to learn how to select and load print media
and how to use the print settings.

The topics included in this chapter are:

e Paper Selection

e Loading Speciality Paper
e Printing a Document

® Printer Settings

e Using the Printer Control Program
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Paper Selection

One of the most important things you can do to assure the
best possible printing performance of your product is to
select the correct paper. Your product produces letter quality
print on most plain bond paper, including cotton bond and
photocopying paper; it does not require special ink jet paper.
However, the print quality varies with different paper types.
Be sure to test a type of paper before you purchase a large
quantity.

Your printer supports the following types of paper. Select the
right paper.

Plain Paper

The product supports paper sizes of letter, legal, and A4 in
portrait orientation. You can use regular copier paper,
cotton bond papers, and typical letterhead. Always use
paper without curls, folds, staples, or damaged edges.

Coated paper

Paper developed for high quality printing with minimal or
no smearing or running when in contact with water or
damp surfaces.

Glossy/Photo Paper
A high gloss, thicker paper that produces the look and feel
of a photograph. Use this paper to produce photo-realistic
prints from your printer.

Transparency

Your transparencies should be products designed for use in
Ink Jet products, with excellent contrast, sharpness, and

colour quality. The transparency is placed in the product

with the image side up.

Iron-on Transfer

Use inkjet T-shirt transfers to create and personalize T-
shirts, sweatshirts, aprons, tablecloths, napkins, tote
bags, and anything else your imagination allows! Use on
any cotton or cotton/poly blend fabric. Your image is
printed in mirror image so when you iron it onto the T-
shirt, the image is viewed correctly.

Greeting Card Stock
You can create greeting cards, business cards, invitations,
announcements, and more.
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g NOTE: When you print on different papers, you have to set the
appropriate paper type in your application. See page 2.10.

Samsung 5F-430 Series HE

Job Finish\ngl Paper | Advancedl

Document Types

& @ w

it “fivid Color Matural Color  Black Only

— Paper Typ:
" Plain Paper il
" Coated Paper
" Glossy/Phato Paper
"~ Tiansparency

 lron-On Trarsfer
" Greeting Card Stock [ Allow Pages to Dy

Guidelines for Special Media

Be sure to read any instructions that come with your special
paper. These instructions provide important information
regarding how to achieve the highest print quality with these
papers.

¢ It is recommended that you feed special paper types one
sheet at a time.

e For transparencies and glossy photo paper, follow these
guidelines:

- Let the printed sheets dry completely before handling or
storing them.

- When a printed sheet has dried completely, cover the
printed side with a sheet of plain (not coated) paper
before storing it, this is recommended even if you place
the sheets in a clear file or plastic holder.

- Do not leave the film in the paper output tray for long
periods of time. Dust and dirt may accumulate on the film
resulting in spotty printing.

- To avoid smudging caused by fingerprints, handle
transparency film and coated paper carefully.

- To avoid fading, do not expose the printed film to
prolonged sunlight.
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e Store unused media flat. Do not remove paper from its
protective packaging until you are ready to use it.

e Store unused media at temperatures between 59 and 86 °F
(15 to 30 °C). The relative humidity should be between
10% and 70%.

e If the print density of your page is very high, light paper
stock may curl slightly due to the large amount of ink. If
you need to print dense graphics, try printing on heavier
stock.

¢ Do not use thicker paper than meets the specifications for
this product. Printing with a paper that is thick enough to
come in contact with the print head nozzles may damage
the cartridge.

Loading Speciality Paper

Follow these guidelines when loading speciality paper:

Load up to: And make sure:

100 sheets of 20lb | The print side is facing you.

plain paper oThe paper is against the right side of the paper support.
*The paper guides rest against the edge of the paper.
10 envelopes *The print side is facing you.

*The envelopes are loaded
vertically against the right
side of the paper support.

eThe stamp location is in the
upper left corner.

10 greeting cards, | eThe print side is facing you.
index cards,
postcards, or
photo cards

oThe cards are loaded vertically against the right side of
the paper support.

oThe paper guides rest against the edge of the cards.
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Load up to: And make sure:

25 sheets of *The glossy or coated side is facing you.

photo paper *The paper guides rest against the edge of the photo

paper.

10 transparencies | eThe rough sides of the transparencies are facing you.

*The paper guides rest against the edge of the
transparencies.

100 sheets of *The print side is facing you.

custom size paper eYour paper size fits within these dimensions:

- Width: 76 mm to 216 mm (3.0 in. to 8.5 in.)
- Length: 127 mm to 432 mm (5.0 in. to 17.0in.)

oThe paper guides rest against the edge of the paper

25 iron-on sYou follow the loading instructions on the iron-on
transfers packaging.

oThe print side (blank side) is facing you.

*The paper guides rest against the edge of the iron-on
transfers.

Paper Guidelines

¢ When loading paper, envelopes, or other special media, keep
these guidelines in mind:

¢ Attempting to print on damp, curled, wrinkled, or torn paper
can cause paper jams and poor print quality.

¢ Use only high quality inkjet or copier grade paper. Avoid paper
with embossed lettering, perforations, or texture that is too
smooth or too rough.

e Store paper in its ream wrapper until ready to use. Place
cartons on pallets or shelves, not on the floor. Do not place
heavy objects on top of the paper, whether it is packaged or
unpackaged. Keep it away from moisture, or other conditions
that can cause it to wrinkle or curl.

¢ During storage, moisture-proof wrap (any plastic container or
bag) should be used to prevent dust and moisture from
contaminating your paper.

¢ Always use paper and other media that conform with those
listed under “Paper Specification” on page 8.5.
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¢ Use only well-constructed envelopes with sharp, well
creased folds.

e DO NOT use envelopes with clasps and/or snaps.

e DO NOT use envelopes with windows, coated linings, self-
adhesive seals, or other synthetic materials.

e DO NOT use damaged or poorly made envelopes.

Printing a Document

This procedure describes the general steps required for
printing from various Windows applications. The exact steps
for printing a document may vary depending on the
application program you are using. Refer to your software
application’s documentation for the exact printing procedure.

The following steps describe the typical process to print from
a Windows environment:

1 Ensure that your Samsung SF-430 is properly connected
to the computer, the product is powered on, and there is
paper in the paper bin.

2 \Verify that you have installed the Samsung software for
your computer. For details, see “Installing Samsung
Software” on page 1.21.

3 Start the program you are using to create the

document, and create or open the document you want
to print.
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4 Choose Print or Print Setup from the File menu.
Make sure that Samsung SF-430 Series is selected
as your default printer. Click Properties or Setup if
you want to make any adjustments that are appropriate
for printing your document. (For details, see “Printer
Settings” on page 2.8.)

Print
— Printer
Mame: Propertiez |
Statug: Default printer; Ready
Type: Samszung 5F-430 Series
Where:  LPTI:
Comment: ™ Piint ta file
— Print range Copie
Lo | Mumber of copies: |1 3:
" Pages [rom:|1 go:l
¥ Callate
) Selention
OK I Cancel

A 1n case of Windows 98

5 Click OK to close the Properties dialogue box.

6 After making any necessary changes to the printing
parameters, click OK to start the print job.

After a moment, the Samsung SF-430 Series Control
Program window appears. You can cancel the print job
as well as seeing how much ink you have left and view
printing tips in this window.

@ 5 amzung 5F-430 Series Control Program on LPT1: [ =] =]
Status |Dpti0ns| Cartridgesl About I
Prirting untitled
1 et
Statug Frinting
Job Progress
(. 8%
Page 1of2
v"_‘ ~ Copy 1of1
: (" - R Time 0:00:10
\) : "
i Cancel Print Ermt Tiest Fage
Cloze Help |

A In case of Windows 98
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For Windows 2000/XP, the Control Program does not
appear. Right-click on the printer icon on the taskbar at
the bottom right corner of the desktop window. From
the pop-up menu, you can select commands to cancel,
pause, or resume printing.

g NoOTE: If you want to use another printer instead of SF-430,
you must disable the scan monitor on the taskbar at the bottom
right corner of the desktop window. The scan monitor is
enabled as long as SF-430 is connected to your computer and
turned on. To disable the scan monitor, right-click on the scan
monitor and select Disable from the pop-up menu.

Printer Settings

You can use the product with all your Windows 95/98/Me/
2000/XP or Windows NT 4.0 applications. Be sure to set
Samsung SF-430 Series as the default printer for all your
Windows operations.

Most Windows software applications allow you to make
changes to the printer settings. This includes settings that
determine how a print job looks such as paper size, paper
orientation, and margins. Settings made in the application to
create the document will usually override settings made in
the printer driver.

d NOTE: You do not need to use any of the front panel buttons
to use the product as a PC printer. For example, if you want to
adjust the printing contrast you do not have to press Contrast
on the front panel. The front panel buttons are used primarily
for copying.

Download from Www.Somanuals.com. All Manuals Search And Download.



Accessing Printer Settings

You can access printer settings by using either of these
methods.

Windows 95/98/Me

e Select the File > Print > Properties or File > Print
Setup command from within any Windows application.

Or

¢ Select Samsung SF-430 Series printer from the
Printers folder, then select File > Properties (or select
the printer icon in the Printers folder, and click the right
mouse button).

Windows NT 4.0

¢ Select the File > Print > Properties or File > Print
Setup command from within any Windows application.

Or

¢ Select Samsung SF-430 Series printer from the
Printers folder, click the right mouse button, then select
Document Defaults from the drop-down list.

Windows 2000/ XP

e Select the File > Print > Properties or File > Print
Setup command from within any Windows application.

Or

e Select Samsung SF-430 Series printer from the
Printers folder, click the right mouse button, then select
Printing Preferences from the drop-down list.
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Printer Properties Tabs (Windows 95/98/Me)

When the Printer Properties are displayed, you can review
and change whatever settings are needed for your print job.

Your printer’s Properties window consists of 4 tabs: Paper,
Quality, Job Finishing and Advanced.

If you access the Printer Properties through the Printers
folder, you can view more Windows-based tabs, as well as
these 4 tabs. For information on the Windows-based tabs,

refer to your Windows User Guide.

NOTE: If you access the Printer Properties through the
Printers folder, any settings made will become the default
settings for the printer. Settings made when the Printer
Properties are accessed through an application File menu and
Print or Print Setup will remain active until the application
you are printing from is closed.

Paper Tab

Use the Paper tab to select what size of paper you have in
your printer, the orientation, the number of copies to print,

Select the paper size you

etc.
Samsung 5F-430 Series EHE
Job Finishing | Document#ﬂualityl Advanced |
— Copie: Qrigntation
7 v Callate =" Partait
[~ Rieverse Page Order " Landscape
Paper Size: Letter (8.5 % 11 in)
g a d 4 4
Statement Ad Legal BS E
‘ 2
S
RN .
Ok I Cancel Help

have loaded in your printer.
If you have a special size of
paper to print on, select
Custom and define its size
in the custom paper size.
The minimum you can use
is 3 by 5 inches and the
maximum is 8.5 by 17
inches.
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Document/Quality Tab

The Document/Quality tab controls the document and
paper type, such as plain, coated, and glossy. It also controls
the quality (resolution) of the printing. Higher resolutions
print better, but take longer and consume more ink. Selecting
Web Smoothing allows you to print clearer images from
the Internet.

Samsung SF-430 Senes [ 7] =]

Job Fiishing | Paper | Dasiment/lualty ] Advanced |

Document Types

2 B a @

DOTEe  “ivid Color Matural Color  Black Only

— Paper Type
' Plain Paper [T
" Coated Paper
' Glossy/Phota Paper
" Transparency

" Iron-On Transfer

" Greeting Card Stock [ &llow Pages to Dy
r— Print Quality .

& Nomal (800 x 600 dpi] B eb Smoothing

8 Il {1200 1T LI Resets to the default settings
Default gs.

€ Masimum (2400 1200 dpi) is.l- . .
Bbout :l--— Shows the printer driver

version.

Ok I Cancel | Help |

Job Finishing Tab

The Job Finishing tab provides options for you to adjust
how the document will appear on the printed page. Job
Finishing options can include Poster, Handout, Booklet
and Two-sided printing.

Samsung SF-430 Series HE

Job Finishing I Paper I Dncument!ﬂualityl Advancadl
* " Poster

' _aut " Booklet
r—Jaob Finizhing Option:

— Two-sided Printing and Binding Edge
I™ Two-sided printing

Ok I Cancel Help
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Booklet

The Booklet option allows you to print a document out as a
booklet. If the Print reloading instructions after the

first side prints is checked, a page will print directing you
how to insert the paper so that the booklet prints correctly.

Samsung SF-430 Series

Job Finishing | Paper I Document/ﬂualityl Advancedl

 Mormal " Poster
" Handout i+

—Job Finighing Option:

+| Sheets Per
8 0
Bundle

— Two-sided Printing and Binding Edge
= [Tvn-sided printing

Frint reloading
¥ instructions after
the first side prints.

A bundle is any number
of sheets of paper folded
together. When printing
with a heavier paper
stock, select a smaller
number of Sheets Per
Bundle.

QK I Cancel | Help

Once your document prints, stack the bundles and bind the

booklet.

1 Take the first bundle from the paper
output tray, fold it in half, and set it

aside.

2 Fold and stack the rest of your bundles,
one on top of the other, until your

booklet is complete.

3 Bind the bundles.

)
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Poster

Choose the Poster option to enlarge the printed document.
If you check Show Crop Marks, the image will print with
crop marks. The white space around the image can easily be
trimmed.

Samsung 5F-430 Series HE
Job Finizhing | Paper | Document/Quali | Advanced |
= Marmal (:'
" Handout " Booklet

—Joh Finizhing Optian:

|2 w2 vl Poster
Size
™ Show Crop Marks

Select Pages to Print... |

— Two-sided Printing and Binding Edge
= [ Two-sided pritting

Ok I Cancel Help

Handout

Choose the Handout option to print multiple pages on a
single sheet of paper.

Samsung SF-430 Series EHE

Job Finizhing | Paper I Dncumenb"ﬂualityl Advancedl

" Poster
" Booklet

|2 = l Mumber of
Frints

™ Print Page Borders

— Two-gided Printing and Binding Edge
™ Two-sided printing

akK I Cancel Help
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Two-Sided Printing

Choose the Two-sided printing option from the Job
Finishing tab to print the document on both sides of the
paper. You can choose the binding type from Long Edge
Binding or Short Edge Binding.

Advanced Tab

The Advanced tab allows you to change how the printer
handles colour printing. You should rarely need to change
these settings.

Samsung 5F-430 Series HE

Joh Finishingl Paper I Document/Qualty  Advanced |

Halitone

— Image
1|
Brightness
4
Contrast
A
Saturation
4
Bed Strength
A

Green Strength

[ o i Rl

-1
=]

Blue Strength

ok I Cancel Help
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Printer Properties Tabs (Windows NT 4.0)

Page Setup Tab

This tab allows you to set page properties including number
of copies, collate, print quality, orientation, reverse order
printing, paper size, and paper type.

E Samsung 5F-430 Series Properties E
Page Setup | Color | Features |
— Copi
s | LI I¥ Collate Capies
— Print Quality Orientation/Order Media Type: 0 acheliice
I - High Speed & Poitrat Plain Paper j
Normal " Landscape
~ High Qualit -~
i g X g [ Reverse Order Printing Il St el
I aimum . . 5
W Click. this to select a paper size.
S et
"\"\‘ V'v-
';\) =2 Iterm | Setting :I
- 3 Paper Size A4 (210 % 297 mm) Il
Media Type Plain Paper
Print Guality Mormal
Orientation Partrait ;I
0k, I Cancel | Help |

Color Tab

Use the Color tab for optimising the graphic and colour print
job. You can adjust halftone shading, brightness and
contrast. You can also select the colour appearance and the

document colour.

H Samsung SF-430 Series Properties [2]x]
Page Setup  Colar | Featurez I
— Color Appearance Brightness a
% Colar | I
" Black
Contrast a
I /
— Document Caolar
& Pt —Hat Spot Help
€ Wiid Colr Samsung 5F-430 Series
= Matural Color
 Shading [Halftane]
@
& e Item | Setting :I
" Matri Paper Size Ad (210 % 297 mm) —
tedia Typpe Plain Paper
& Brush Frint Quality Mormal ﬂ
izt abine Birebesit
ak. I Cancel | Help
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Feature Tab

You can select the Dry Time Delay option and the two-sided
printing option. You can also access Cartridge Maintenance
features from this tab.

%] Samsung 5F-430 Series Properties 21|

Page Setupl Color  Features |

i~ Print Option;

I

=

Lartidge Maintenance |

[E{=am Fallers (Hagak
r~ Two-Sided Printing = Bollers [ agaki] |

& None
" Long Edge —Hot Spat Help
" Short Edge

¥ Frint Irstruction Shest

Samsung 5F-430 Series

Itemn | Setting ﬂ
Paper Size A4 (210 % 297 mm) I
Media Tupe Plain Paper

Defauls About Samzung | E?{:ﬂg&zlgy gs:l';" aaill ﬂ

oK I Cancel | Help |

NOTE: In Windows NT 4.0, Poster, Handout, and Booklet
printing are not provided.

Download from Www.Somanuals.com. All Manuals Search And Download.



Printer Properties Tabs (Windows 2000/XP)

Paper Quality Tab

This tab allows you to select paper source, paper type, print
quality, and colour. The Advanced button under this tab
allows you to select advanced document settings including
paper size, print resolution, and colour intent.

&% Samsung SF-4 30 Series Document Properties 2=l

Layout  Paper/Quality |

— Tray Selection
Paper Source: I Automatically Select j
Media: I Flain Paper j
— Quality Setting:
i Best " Normal " Dyaft [T Custom
— Color
" Black & White & Calor

oK Cancel

Layout Tab

Use the Layout tab to select print orientation, and page
order.

1'*' Samsung SF-430 Series Document Properkieses ﬂﬂ

Layout | Paper/Guality I

— Orientation

" Landscape

—Page Order

' Front to Back
" Back to Front

Pages Per Sheet: I 1 'l

Advanced... |
oK I Cancel |

PRINT
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Printer Properties Buttons & Icons
¢ Click OK when done reviewing or making changes.

¢ Click Cancel if you want to exit the tab menus without
applying any changes.

¢ Click Help to view the online Help feature and tab menu
details.

o Click the ? icon in the title bar. Position the ? pointer over
the parameter in question and click to see a pop up window
explaining that parameter.

Using the Printer Control Program

The SF-430 Series Control Program contains setup options
that define the operation of your product.

g NOTE: The Printer Control Program is not available in Windows
2000/XP.

Accessing the Printer Control Program

1 Click Start > Programs> SAMSUNG SF-430 Series>
Printer Control Program.

g NOTE: Windows NT 4.0 users can also access the Printer
Control Program from the Printer Properties window. See page
page 2.15.
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2 The Samsung SF-430 Series Control Program window
appears. The appearance of the window may be
different from the ones below depending on your
Windows operating system. Click the appropriate tab for
the options you want to display, and make the
necessary changes on each tab.

g NorTE: Click Help on any tab in the Control Program window
to access on-line Help.

Status Tab

The Status tab gives you general status information on the
printer. You will see this window when the printer is printing
(unless you've set the Control Program Options to Run
Minimized, using the options on page 2.20).

Once a print job has started, you can use this window to
cancel the print job or monitor the job progress.

The ink level of the cartridges is also displayed. Use the
gauges to help you determine when they need replacing.

% Samsung 5F-430 Series Control Program on LPT1: | _ =] =]

Status | Dptions | Cartridges | &bout |

Printitg Mohe
L Al
Status |dle
I'qub Frogress
Page
= Co
. pit
S
%' q_‘_ T Time
\ ]
- el Ptk I Prirt T est F'agn:’l NT 4_'0 )
. provides this
button in the
Cartridge tab.

Help |

A 1n case of Windows 98
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Options Tab

From the Options tab, you can control some of the
behaviour of the Control Program. The options available will
vary depending on your Windows operating system. Some of
the options activate under a specific printing environment
such as network printing. Click Help for further information.

#% Samsung SF-430 Series Control Program on LPT1: MmE B

caidges | about |

A In case of Windows 98.
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Cartridges Tab

The Cartridges tab gives you access to several different
cartridge functions. From here, you can install new
cartridges, change them, clean your print nozzles, align your
cartridges, or order supplies from the internet.

#% Samsung SF-430 Series Control Program on LPT1: | _ [ =]

Status | Options ||

Ink Lewels

Not available in Install/Change Cartridge |
Windows NT 4.0.

Clean Print Nozzles |

Order Supplies
Align Cartridges |

Cloge | Help

A 1n case of Windows 98

g NOTE: If you are using Windows 2000/XP, you can access the
Cartridge Maintenance tab through the printer properties by
taking the following steps:

1. Click Start > Settings > Printers.

2. Right-click on the Samsung SF-430 Series printer
from the Printers folder.

3. From the pop-up list, select Properties.

4. Click the Cartridge Maintenance tab.

About Tab

The About tab gives you the program version number. If you
click on the globe image on the bottom of the window, you
will be connected to the Samsung web site provided you are
connected to the internet.
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CopPy

You can use your SF-430 like a standard copier. You don’t
even have to turn your computer on. The buttons on the
operation panel let you make all the basic settings: paper
type and size, copy size, copy contrast and quality, number
of copies, and colour or black and white.

This chapter includes:

e Setting Paper Size and Type
e Copying a Document
e Setting Copy Options

e Changing Default Settings

Download from Www.Somanuals.com. All Manuals Search And Download.



Setting Paper Size and Type

First make sure you have paper loaded, following the
instructions in “Loading Paper” on page 1.11. Then you have
to set the paper size and type using the front panel buttons.

NOTE: These settings are applied to the stand-alone copy
mode only.

Paper Size

After loading paper, take the following steps to set the paper
size from the front panel:

1 Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

2 Press the Scroll buttons (<€ or ») until you see
“3.COPY SETUP” and then press Enter.

3 The display shows the first option “PAPER SIZE”. Press
Enter to access the Paper Size option.

The current setting is tagged with a « at the right end
of the display.

4 Press the Scroll buttons (< or ») to select the paper
size you are using in the display.

LETTER, A4, and LEGAL sizes are available.

5 Press Enter to save the selection and return to Standby
mode.

g NOTE: When you use legal-size paper, do not pull out the
paper output tray. If you do, a paper jam may occur.
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Paper Type

You can use special media such as inkjet, transparency, and
photo paper as well as plain paper. After loading any special
type of media, set the paper type using this menu:

1 Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

2 Press the Scroll buttons (<€ or ») until you see
“3.COPY SETUP” and then press Enter.

3 Press the Scroll buttons (<€ or ») until you see “PAPER
TYPE” and press Enter.

The current setting is tagged with a  at the end of the
display.

4 Press the Scroll buttons (<€ or ») until you see the
paper type you are using in the display.

5 Press Enter to save the selection and return to Standby
mode.

Copy m
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Copying a Document

Simply pressing the Start Copy buttons on the front panel
allows you to copy using the default copy quality and quantity
settings: one normal page. You can change the default copy
settings which will apply when copying documents using the
corresponding buttons on the front panel. See “Setting Copy
Options” on page 3.5.

Follow these steps to copy using the front panel:

1 Feed the document to be copied face down into the
Automatic Document Feeder using light forward
pressure until "DOCUMENT READY” appears in the LCD
display.

If necessary, adjust the document guides to match the
width of the document.

You can insert up to 30 sheets at a time. If you insert
more than one sheet, make sure the bottom sheet
enters first. Stagger the leading edge of the sheets
slightly, and insert the sheets with a slight push to
ensure smooth feeding.

To add pages while the document is being copied, insert
them into the loading slot on top of the already loaded
sheets.

If you're loading pages that are unusually thick or thin,
feed one sheet at a time.

2 Customise the copy settings including copy quality,
contrast, number of copies, and copy size if necessary.
See “Setting Copy Options” on page 3.5.
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3 When you are finished setting the copy options, press
Start Copy Black to begin a black and white copy or
Start Copy Color for a colour copy.

Start Copy
GE’CK Color j

g NoOTES: If you want to cancel the copy job, press Cancel/
Reset during copying

Setting Copy Options

The following buttons on the front panel let you make all the
basic settings: copy quality, contrast, number of copies and
copy size. You can cancel the settings and reset to default
settings by pressing Cancel/Reset at any time while you
are setting the options.

d NOTES: The option settings for the current copy job will be

automatically reset to their default status (page 3.9) 2 minutes
after the job is completed. If necessary, you can reset the copy
options immediately by pressing Cancel/Reset.

Quality

To select the copy quality, use the Quality button on the
operation panel. You can select DRAFT, NORMAL, or BEST.
The BEST mode is good for documents with fine details. The
copy quality is good but the copy speed is low. The NORMAL
mode works well for normal documents (text). The DRAFT
mode can be used for fast copying with lower resolution.

Copy m
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To select copy quality:

1

3

Press Quality. The current setting is tagged with a «
at the end of the display.

Scroll through the options available by pressing Quality
repeatedly or using the Scroll buttons (< or ).

When the desired mode is displayed, press Enter to
save the selection.

NOTE: While the Paper Save feature is active, you cannot
change the quality using the Quality button. The quality is
fixed to "NORMAL".

Contrast

Contrast is the difference in brightness between the lightest
and darkest parts of a printed document. You can adjust the
contrast the product will use to copy a document. Adjust it
according to how light or dark your document is.

You can select LIGHTEN, PHOTO, DARKEN or NORMAL.
The LIGHTEN contrast is good for documents containing dark
images. The NORMAL contrast works well with a standard
document. The DARKEN contrast works well with light print
or faint pencil markings. Choose the PHOTO contrast if you
are copying a photograph.

To select the contrast:

1

Press Contrast. The current setting is tagged with a «
at the end of the display.

Scroll through the options available by pressing

Contrast repeatedly or using the Scroll buttons (< or
>).

When the desired mode is displayed, press Enter to
save the selection.
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Copy Page

You can select the number of copies you want from 1 to 99.
To change the number of copies:

1 Press Copy Page on the front panel.

2 Enter the desired number of copies using the number
keypad.

3 When the desired number is displayed, press Enter to
save the selection.

If you select multiple copies, you can set your product to sort
the copy job. For details, see page 3.8.

NoOTE: When making a colour copy, you cannot make multiple
copies.

Zoom Rate

You can reduce or enlarge the size of a copy image from 25%
to 400% using the Zoom Rate button on the front panel.

To select the zoom rate from pre-defined copy sizes:

1 Press Zoom Rate until the setting you want appears on
the display.

2 Press Enter to save the selection.

To fine-tune the size of copies:

1 Press Zoom Rate until you see ‘CUSTOM 100% <« ' on
the display and then press Enter.

2 Enter the desire rate using the number keypad

3 Press Enter to save the selection.

g NOTE: When the Paper Save feature is active, the zoom rate
you previously selected is ignored.

Copy m
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Collation

If you are making multiple copies, you can set your product
to sort the copy job and change the print order.

1

Press Setup. The display shows the "1.SYSTEM SETUP”
on the bottom line.

Press the Scroll buttons (< or ») until you see
“3.COPY SETUP” and then press Enter.

Press the Scroll buttons (< or ») until you see
“COLLATE"” and then press Enter.

The current setting is tagged with « at the end of the
display.

Press the Scroll buttons (< or ») to select ON and
press Enter.

The product will now collate the copy job. For example,
2 copies of a 3 page job; it will print one complete
document followed by the second complete document,
(e.g.1,2,3then 1, 2, 3).

The OFF setting disables the collation and you don't
need to continue the following steps. The product will
print all the copies of one page and then the next page.

The display prompts you to select the copy print order.
Select the desired print order by using the Scroll
buttons (<« or »).

¢ NORMAL : Set to collate in normal order.

e REVERSE : Set to collate in reverse order. The
product prints the last page first so that you do not
need to rearrange the printed copies.

Press Enter to save the selection and return to Standby
mode.

NOTES:
¢ When you make a colour copy, collation is disabled.
o If the memory gets full while making black and white copies

using collation, collation automatically is disabled.
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Changing Default Settings

The copy options including copy quality, contrast, number of
copies and copy size can be set to the most frequently used
modes. When a document is copied, the default settings will
be used unless otherwise you do not change for the individual
copy job by using the corresponding buttons on the front
panel.

To create your own default settings:

1 Press Setup on the front panel. The display shows
“1.SYSTEM SETUP” on the bottom line.

2 Press Enter.

3 Press the Scroll buttons (<€ or ) repeatedly until you
see “SET DEFAULT".

4 Press Enter. The display shows the first option
“CONTRAST".

5 Press the Scroll buttons (<€ or ») repeatedly to scroll
through the available setup options.

6 When the desired option appears, press Enter.

7 Change the setting using the Scroll buttons (< or )
and then press Enter to save the selection.

8 Repeat steps 5 through 7 as necessary.

9 To return to Standby mode, press Cancel/Reset.

Copy m
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SCAN

Scanning with the Samsung SF-430 lets you turn pictures
and text into digital files on your computer. Then you can fax
or e-mail the files, display them on your web site, or use
them to create projects that you can print out using
Samsung SmarThru software which comes with the product.

This chapter includes:

e Scanning Basics
e Starting Scan from the Front Panel

e The Scanning Process with TWAIN-enabled

Software
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Scanning Basics

Your SF-430 offers three ways to start scanning. These
include:

e From the Samsung SmarThru software: Launch Samsung
SmarThru and open the Scan Wizard to start scanning.
Please refer to the SmarThru User’s Guide.

e From the front panel on your product: Use the Scan To
button on the front panel to initiate scanning. The
SmarThru system launches automatically on your PC and
the Scan Wizard window opens on the desktop window.

e From TWAIN-compliant software: You can use other
software including Adobe PhotoDeluxe and Adobe
Photoshop.

NOTES:
e To scan with your product, you must install the MFP driver.

e Scanning is done through the same LPT or USB port that is
currently assigned for your printer port.

Starting Scan from the Front Panel

You can quickly start scanning from the front panel on your
product. The Samsung SmarThru program automatically
launches and allows you to select the desired scan service.
Take the following steps:

1 Make sure that your computer and SF-430 are turned
on. You will see the scan monitor icon on the taskbar at
the bottom right corner of the desktop window unless
you disable or have turned it off.

||E<EEGE% £:43 PM

Scan monitor
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2 Load the document face down into the Automatic
Document Feeder.

3 Adjust the document guides to match the width of the
document.

4 Slide the sheet down into the document tray until it’s
gripped by the product.

5 Press Scan To on the front panel.

g NOTE: If you press Scan to when the scan monitor on the
desktop window is disabled or turned off (see page 4.2), ‘PC
NOT AVAILABLE’ appears on the SF-430 display and scanning is
not possible.

SCAN m

Download from Www.Somanuals.com. All Manuals Search And Download.



6 The Samsung SmarThru starts automatically and the
Scan Wizard window opens.

¥ Scan Wizard - Samsung SmarThru 3

ScanTo Optiohs Yiew Help

iz

_Jgﬂ [

! Scan Wizard

EEIENE

Scan to Scan to Scan to Sean to

Scan Copy Email FAX WEB OCR
SAMSUNG DIGITa g
Fieady [ [NUM 7

The Scan Wizard lets you use the following services:

¢ Scan
Lets you scan the documents and save them in the
Image Manager. The Image Manager is an image
database manager and image-editing program.

* Copy
Lets you use your product to produce professional
quality copies. You can adjust the image size and
make advanced settings.

e Scan to Email
Lets you scan the documents, then launches a New
Message form to send the just scanned image
attached to a new mail. The email account must be
configured in the Samsung SmarThru system to
enable e-mail services.

¢ Scan to FAX
Lets you scan the documents then launches a New Fax
form which helps you send them as a fax image.

e Scan to WEB
Lets you scan the documents for further publishing to
the Web.
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e Scan to OCR
Lets you scan the documents and pass them to the
OCR program. OCR (Optical Character Recognition) is
the process of converting a scanned image into text
that you can edit in a word processing program. After
you scan your document, the software processes or
“recognises” it. Then you can edit it and either save
the file or open it in @ word processing program on
your computer.

7 Click the desired service.

8 The Samsung Scan Manager for the selected service

opens. Adjust the scan settings. You can use the Help
button to get on-line help.

= Samsung Scan Manager
Scan |
— Setting:
Image Type: |258 Colors j
Resolution: 300 dpi
— Scan Area
Scan Size: ICustom j
Left: [ooe | Top |0te
width:  [858  Height  [11.86
Urits: & inches © mm

mnm:s Image Adjust... | Defaults |
’TI Prescan | Cancel | Help |

9 To start scanning, click Scan.

For further information, please refer to the SmarThru
User’s Guide which came with your product.

g NOTE: If you want to cancel the scan job, press Cancel/
Reset at any time.

SCAN m
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The Scanning Process with TWAIN-
enabled Software

If you want to scan documents using alternative software,
you will have to use a TWAIN-compliant software such as
Adobe PhotoDeluxe or Adobe Photoshop. The first time you
scan with your SF-430, you will need to select it as your
TWAIN source in the application you will use.

The basic scanning process involves a number of steps:
¢ Placing your photo or page on the document glass.

¢ Opening an application (such as PhotoDeluxe or
Photoshop).

¢ Opening the TWAIN window and setting scan options.
e Scanning and saving your scanned image.

You have to follow the program’s instructions for acquiring an
image. Please refer to the application user’s guide.

Download from Www.Somanuals.com. All Manuals Search And Download.



FAX

This chapter includes:

e Sending a Fax

® Receiving a Fax

e Automatic Dialling
e Advanced Faxing

o Additional Feature
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Sending a Fax

Preparing Documents for Faxing

Use the following guidelines to prepare your documents for
faxing:

¢ Do not attempt to feed the following types of documents
into the Automatic Document Feeder:
- carbon-paper or carbon-backed paper
- coated paper
- onion skin or thin paper
- wrinkled or creased paper
- curled or rolled paper
- torn paper

e Remove all staples and paper clips before feeding the
document.

e Make sure any glue, ink or correction fluid on the paper is
completely dry before loading the document.

¢ Do not load documents containing different sizes or weights
of paper.

Acceptable Documents (for ADF!)

Single Sheet 2 or More Sheets

Max 8.5in. (W) x 14in. (L) | 8.5in. (W) x 11.7 in. (L)
' (216 mm x 356 mm) (216 mm x 297 mm)
Document Size
Min 5.8in. (W) x 5.0 in. (L)
' (148 mm x 128 mm)
Effective Scanning Width 8.26 in. (210 mm)

Number of sheets which

can be loaded at a time Up to 30

0.05 mm ~ 0.07 mm

0.15 mm ~ 0.2 mm 0.075 mm ~ 0.12 mm

Thickness of document

Print Quality Uncoated on both sides

1.ADF stands for Automatic Document Feeder. It allows you to stack original
documents, which will be faxed or copied one by one.
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Adjusting Document Settings

When setting typical text based documents, the default
document settings produce good results.

However, if you send documents that are of poor quality, or
contain photographs, you can adjust the following features to
ensure a higher quality.

Resolution

Resolution is a measure of the fineness of clarity of a
printout. Low resolution may cause text and graphics to have
a jagged appearance, while higher resolutions provide
smoother curves and lines, crisp text and graphics, and a
better match to traditional typeface designs.

Press Resolution on the front panel to increase resolution.
By pressing Resolution repeatedly or using the Scroll
buttons (< or »), you can choose between STANDARD,
FINE, and SUPERFINE. Press Enter to save the selection.

The document types recommended for quality settings are
described below.

e Standard works well for normal handwritten typed, or
printed documents.

¢ Fine is good for documents containing a lot of detail.

e Superfine works well for documents containing extremely
fine detail. Superfine works only if the receiving machine
also has the SUPERFINE feature.

NOTES:

e Superfine resolution is not available to store the document.
Superfine documents will be stored to memory with Fine
mode for the advanced faxing like delayed transmission. And
for a normal fax, the pages will be sent one by one as soon as
they are scanned, even though Send From Memory is set to
ON.

o If the product is set to Superfine resolution and the receiving
fax machine does not support Superfine resolution, your
product will transmit using the highest resolution mode
supported by the remote fax machine.
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Contrast

Contrast is the difference in brightness between the lightest
and darkest parts of a printed document. You can adjust the
contrast your product will use to send faxes. Adjust according
to how light or dark your document is.

Press Contrast on the front panel to compensate for the
brightness or darkness of your faxed document. By pressing
Contrast repeatedly or using the Scroll buttons (< or )
after loading a document, you can choose between LIGHTEN,
PHOTO, DARKEN, or NORMAL. Press Enter to save the
selection.

¢ Lighten works well with dark print.

e Photo is used when faxing photographs or other
documents containing shades of grey.

NOTE: The Photo setting is only enabled when sending a black
and white fax. If you select the Photo setting and try to fax
documents with colour images, the contrast will be set to
‘NORMAL' automatically.

e Darken works well with light print or faint pencil markings.
The light image and text on the original document will be
darker on the printed page.

e Normal works well with standard typed or printed
documents.
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Setting Default Resolution and Contrast

You can set the default document settings including contrast
and resolution. The default mode will be used when a
document is sent unless you change the setting for individual
operation.

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press Enter.

3 Press the Scroll buttons (<€ or ») until you see “SET
DEFAULT".

4 Press Enter. The display shows the first option
“CONTRAST".

5 To set the default contrast, press Enter.
Or,

To set the default resolution, press the Scroll buttons
(< or ) until you see "RESOLUTION” and then press
Enter.

6 Press the Scroll buttons (<€ or ») until you see the
desired mode in the display.

7 Press Enter to save the selection.

8 Press Cancel/Reset to return to Standby mode.
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Loading Document

1 Load the top edge of your document face down in the
document feeder.

2 Adjust the document guides to match the width of the
document.

3 Slide the sheet down into the document tray until it's
gripped by the product.

& 5

The automatic document feeder seizes and pulls the
page in. The display shows "DOCUMENT READY"” and the
remaining memory capacity.

You can insert up to 30 sheets (75 g/m? Paper) at a
time. If you insert more than one sheet, make sure the
bottom sheet enters first. Stagger the leading edge of
the sheets slightly, and insert the sheets with a slight
push to ensure smooth feeding.

To add pages while the fax is sending, insert them into
the loading slot on top of the already loaded sheets.

4 If necessary, use the Resolution button to change the

resolution and the Contrast button to change the
contrast. For details, see page 5.3.
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Sending a Fax Automatically

1

Load the top edge of your document face down in the
document feeder.

You can adjust the document settings to suit your fax
needs. For details, see “"Adjusting Document Settings”
on page 5.3.

Enter the phone number of the remote fax machine
using the number keypad.

If you make a mistake while entering a number, move
the cursor under the wrong digit by using the Scroll
buttons (<« or ), and enter the correct number or
press Search/Delete to delete the number.

When the number is correct, press Start FAX Black to
send a black and white fax or Start FAX Color to send
a colour fax. The product dials the number and begins to
transmit.

Sending a Fax Using Manual Dial

1

Load the top edge of your document face down in the
document feeder.

You can adjust the document settings to suit your fax
needs. For details, see page 5.3.

Press OHD/V.Req on the front panel or lift the handset
on the product. You hear a dial tone if the telephone line

is correctly connected.

Enter the remote fax phone number using the number
keypad.
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5 When you hear the fax tone from the remote machine,
press Start FAX Black to send a black and white fax or
Start FAX Color to send a colour fax.

Sending a Fax After Talking

You can send a fax after speaking with a person at the remote
site.

1 When finished talking, instruct the person at the remote
location to start their fax machine and hang up.

The remote fax machine will send the initial fax tones.

2 Wait until you hear the fax tone from the remote fax
machine.

3 Slide the document into the document feeder.
4 Ppress Start FAX Black to send a black and white fax or

Start FAX Color to send a colour fax and replace your
handset.

Cancelling a Fax

To cancel a fax, press Cancel/Reset at any time during the
transmission.
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Confirming Transmission

When the last page of your document has been sent
successfully, the product beeps and returns to Standby
mode.

If something went wrong during your fax transmission, an
error message appears on the display. For a listing of error
messages and their meanings, see page 7.6.

If you receive an error message, press Cancel/Reset to
clear the message and try to send the document again.

You can set your product to print out a confirmation report
automatically each time sending is completed. For details,
see “Sending Confirmation” on page 5.36.

Automatic Redial

When you send a fax, if the number you have dialled is busy
or there is no answer, the product will automatically redial the
number every three minutes up to 5 times (factory default).

The display shows “"RETRY REDIAL?” to redial the number
without waiting, press Enter. To cancel the automatic redial,
press Cancel/Reset.

You can change the time between redials and the number of
redial attempts using the Fax Setup options. See page 5.40
and page 5.41 respectively.
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Redialling

The memory in your product retains the last 10 numbers
called, and the last 30 numbers received, provided the CLI
(Caller Line Identification) Service is available.

NOTE: The CLI Service may be unavailable depending on your
area or country.

Dialling the Last Number You Dialled

To redial the number last called:

1

Press Redial/Pause. The display shows the last
number you dialled.

Lift the handset to make a call.

If a document is loaded in the document feeder, press
Start FAX Black for black and white faxing, or Start
FAX Color for colour faxing when the display shows
“PRESS FAX BLACK OR COLOR”.

To search through the Redial memory:

1

Press and hold Redial/Pause for 2 seconds. The
display shows “Redial” on the bottom line.

Press Enter. The display shows the last humber you
dialled.

If you have dialled the same number multiple times, the
product does not count the duplicates.

Press the Scroll buttons (< or ) to search through
the memory until you see the number you want to dial.

Press Enter.

Lift the handset to make a call.

If a document is loaded in the document feeder, press
Start FAX Black for black and white faxing, or Start
FAX Color for colour faxing when the display shows
“PRESS FAX BLACK OR COLOR".
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Dialling the Number You Received

1 Press and hold Redial/Pause for 2 seconds. The
display shows “Redial” on the bottom line.

2 Press the Scroll buttons (<€ or ») to select “"CALLER
ID” and then press Enter.

3 Press the Scroll buttons (<€ or ) to search through
the memory until you see the number you want to dial.

4 Press Enter.

5 Lift the handset to make a call.

If a document is loaded in the document feeder, press
Start FAX Black for black and white faxing, or Start
FAX Color for colour faxing when the display shows
“PRESS FAX BLACK OR COLOR".

Voice Request

If you are sending or receiving a document and need to speak
to the other person during the same phone call, use Voice
Request to alert the person at the remote site. You can also
respond to a Voice Request made by the person at the remote
end.

Sending a Voice Request

1 Press OHD/V.Req while a document is being sent or
received. A voice request signal is stored and then sent
to the remote fax machine after the document has been
sent or received. “VOICE REQUEST" is seen in the
display.

2 When the phone rings, pick up the handset and answer
it.

You can cancel a Voice Request by pressing OHD/

V.Req again while you are sending or receiving a
document. “VOICE REQUEST" disappears from the

display.
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Answering a Voice Request

When the phone rings after sending or receiving a fax, pick
up the handset and answer it.

If you do not answer the Voice Request, the product prints
out the number that made the Voice Request, as well as the
time and date that the request was made.

o

Using the Toll Save Transmission

If you have set a specific toll save time using the FAX SETUP
menu (see page 5.40), you can quickly set your document(s)
to be sent at the preset time using the SAVE Toll button on
the front panel. Using this feature, you can take advantage
of lower long distance rates at night, for example.

1 Load the document(s) face up into the ADF until
“"DOCUMENT READY” appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press SAVE Toll. The display prompts you to enter the
fax number.

NOTE: If you have not set a toll save time, specify the time in
the Fax Setup menu first.

4 Enter the number of the remote fax machine using the
number keypad.

You can also use a one-touch button or press Speed
then use a 2-digit speed dial number.

5 Press Enter to confirm the number.
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6 The display asks you to enter another fax number to
send the document.

7 Select “1.YES” by pressing 1 and repeat from step 4 to
enter another fax number.

Note that you cannot use Group dial numbers for
another fax number.

8 To send to one location or when you complete the last
fax number setting, select "2.NO"” by pressing 2 in the
“"ANOTHER FAX NO.?” screen.

9 Press Enter. The document is scanned into memory
with Black and White mode and the display shows a
reminder that a toll save transmission is reserved at the
preset time.

‘28~DCT igbgEcEm|
i - o ransmission will be
BEEENNNRRRNESRES]  ctart ot 11:45 PM,

NOTES:
¢ You cannot use a colour fax for a toll save transmission.

¢ To cancel the job reserved in memory, see “Cancelling a
Scheduled Operation” on page 5.35.
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Receiving a Fax

About Reception Modes

Your product has four reception modes:

e In FAX mode, the product answers an incoming call and
immediately goes into receive mode.

e In AUTO mode, the product answers an incoming call
expecting to receive a fax. If the product does not sense a
fax signal, it will continue to sound the ringing tone to tell
you it is a phone call. If you do not lift the handset during
the ringing, the product will switch to automatic fax
reception mode.

¢ In ANS/FAX mode, an answering machine answers an
incoming call, and the caller can leave a message on the
answering machine. If your product senses a fax tone on
the ling, the call automatically switches to the fax machine.

NOTE: To use the ANS/FAX mode, attach an answering
machine to the EXT jack on the back of your product (see page
1.9).

¢ In TEL mode, the automatic fax reception is turned off. You
can receive a fax by picking up the handset and pressing
Start FAX Black or Start FAX Color on the front panel
of your SF-430 series product.

¢ In DRPD mode, you can receive a call using the Distinctive
Ring Pattern Detection (DRPD) feature. “Distinctive Ring” is
a telephone company service which enables a user to use a
single telephone line to answer several different telephone
numbers. This mode is displayed when you have set up the
distinctive ring pattern. For details on this feature, see page
5.41.
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The current reception mode is displayed when the product is

in Standby mode.
1z:88
o8 t
FAx reucrgggion mode

If you seldom use the fax line for voice conversations, set
your product to receive a fax automatically by selecting FAX
mode.

= [T
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e

NoOTE: While the product is printing a received document,
scanning for fax or copy job is not possible. After the current
print job is completed, try the job.

Loading Paper for Receiving Faxes

The instructions for loading paper in the paper input tray are
the same whether you are printing, faxing, or copying,
except that faxes can only be printed on letter-, A4-, or legal-
sized paper. See “Loading Paper” on page 1.11 for
instructions.

After loading paper for receiving faxes, set the paper size to
the size of paper you normally load in the paper bin. Your
product uses this setting when printing reports and
determining auto reduction for incoming faxes. See page
5.39 to set the paper size.

from PC. If you are loading special-sized media for your current
print job, do not change this setting. After you have finished
printing, reload the original paper for fax printing.

g NOTE: The FAX PAPER SIZE setting does not affect the printing
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Receiving Automatically in FAX
Mode

Your product is preset to FAX mode at the factory. If you have
changed the receive mode, take the following steps to
receive faxes automatically:

1 Press Receive Mode on the front panel repeatedly
until you see “FAX". Then, press Enter.

2 When you receive a call, the product answers the call on
a specified number of rings and receives a fax
automatically. To change the number of rings, see “Fax
Setup Options” on page 5.38.

To adjust the ringer volume, see “Setting Sounds” on page
1.41.

Receiving in AUTO Mode

1 Press Receive Mode on the front panel repeatedly
until you see "AUTO". Then, press Enter.

2 When you get a call, the product answers it.

If a fax is being sent, the product goes into reception
mode.

If the product does not detect a fax signal, it will
continue ringing to tell you it is a phone call. You should
pick up the handset to answer the call, or it will switch
to automatic reception mode.
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Receiving Automatically in ANS/
FAX Mode

For this mode, you must attach an answering machine to the
EXT jack on the back of your product (see page 1.9).

1 Press Receive Mode on the front panel repeatedly
until you see "ANS/FAX". Then, press Enter.

2 When you receive a call, the answering machine will
answer.

If the caller leaves a message, the answering machine
stores the message as it would normally. If your product
hears a fax tone on the line, it automatically starts to
receive the fax.

NOTES:

e If you have set your product to ANS/FAX mode and your
answering machine is switched off, or no answering machine
is connected to your product, your product will automatically
go into FAX mode after predefined rings. The ring count may
vary depending on your country.

If your answering machine has a ‘user-selectable ring

counter’, set the product to answer incoming calls within 1

ring.

e If you are in TEL mode (manual reception) when the
answering machine is connected to your product, you must
switch off the answering machine, or the outgoing message
from the answering machine will interrupt your phone
conversation.

Download from Www.Somanuals.com. All Manuals Search And Download.




Receiving Manually in TEL Mode

You can answer calls using the handset, and start the product
to receive a fax.

1 Press Receive Mode on the front panel repeatedly
until you see “TEL". Then, press Enter.

2 When the telephone rings, pick up the handset and
answer it.

3 If you hear a fax tone, or if the person on the other end
asks you to receive a document, press Start FAX
Black or Start FAX Color.

4 Replace the handset. The product begins receiving and
returns to Standby mode when the reception is
complete.

Receiving Manually Using an
Extension Telephone

This features works best when you are using an extension
telephone connected to the EXT jack on back of your product
(see page 1.9). You can receive a fax from someone you are
talking to on the extension telephone without having to go to
the fax machine.

When you receive a call on the extension phone and hear fax
tones, press the keys “*9*” (star nine star) on the extension
telephone.

The product receives the document.

Press the buttons slowly in sequence. If you still hear the fax
tone from the remote machine, try pressing “*9*” once
again.

“*9*" is the remote receive start code preset at the factory.
The first and the last asterisks are fixed, but you can change
the middle number to whatever you choose. For more
information, see page 5.41.
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Receiving Using DRPD Feature

You can not set ‘DRPD (Distinctive Ring Pattern Detection)’ as
the receive mode using the Receive Mode button on the

front panel if you have not set up your product for use with
the DRPD service and turned on the feature (see page 5.41).

When the receive mode is set to "DRPD,” if someone calls
using the number assigned for telephone communication,
your product rings in the pattern you registered for voice
calls. When you hear this pattern, simply pick up the handset
of the telephone connected to your product and talk.

When someone sends a fax using the number assigned for
fax communication, your product receives the fax
automatically.

You can select the other receive mode using Receive Mode
button on the operation panel to temporarily disable the
DRPD service.

Receiving in Colour

Your product has been set to receive faxes in colour from fax
machines with colour capability. When receiving a fax, your
product detects if the incoming fax is in colour or black and
white, and prints the fax accordingly.

Receiving Fax in Memory

Since your product is a multitasking device, it can receive
faxes while you are making copies or printing. If you receive
a fax while you are copying or printing, your product stores
the incoming fax in memory. Then, as soon as you finish
copying or printing, the product automatically prints the fax.
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Forwarding Received Faxes

You can set your product to forward incoming faxes to
another fax number during a specified time period. When the
fax arrives at your product, it is stored in memory. Then, your
product dials the fax humber you have specified and sends
the fax.

If it cannot forward a fax after repeated attempts because of
an error, such as the number being busy and redials failing,
your product will print a message confirmation report
showing the result of the transmission. If it runs out of
memory while receiving a fax, it will terminate the incoming
fax and only forward the partial pages already stored in
memory.

You can also select the fax forwarding option which allows
you to print the fax on your product if fax forwarding is
completed without an error.

To use fax forwarding, take the following steps:
1 Press FAX Forward.

2 Select the fax forwarding option by pressing FAX

Forward or using the Scroll buttons (<€ or ). The
following options are available:

¢ OFF: turns the fax forwarding off.

* FORWARD: forwards the fax to a specified number.
Your product does not print the fax.

* FORWARD & PRINT: forwards the fax to a specified
number and prints the fax on your product.

3 Press Enter to save the selection.

4 If you choose to forward faxes, enter the fax number
where you would like the fax to go, and then press
Enter to save your selection.

5 Enter the date using the number keypad you want to
start forwarding incoming faxes and then press Enter.

Download from Www.Somanuals.com. All Manuals Search And Download.



6 Enter the time using the number keypad you want to
start forwarding incoming faxes and then press Enter.

7 Enter the date using the number keypad you want to
end forwarding incoming faxes and then press Enter.

8 Enter the time using the number keypad you want to
end forwarding incoming faxes and then press Enter.

9 The display shows “FW” at the left side of the receiving
mode, for example “FW FAX" at the bottom right corner
to indicate that the fax forwarding feature is activated.

When the time you have set to start forwarding is up,
the display shows "FORWARDING".
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Automatic Dialling

One-Touch Dialling

One-Touch dialling lets you use any of the 10 one-touch
buttons to automatically dial a number.

Storing a Number for One-Touch Dialling

1

Press and hold one of ten one-touch buttons for more
than 2 seconds. The display shows "Txx:”, where xx
represents the selected one-touch button number.

If a number is already stored in the location you chose,
the display shows the number. To replace the number
with other phone number, select "1.RENEW". Otherwise,
select "2.0THER" and start over with a different one-
touch button.

Enter the number you want to store by using the
number keypad and then press Enter.

To insert a pause between numbers, press Redial/
Pause. ‘P’ appears on the display.

If you make a mistake while entering a number, press
Search/Delete and re-enter the correct number.

To assign a name to the number, enter the desired
name. For information on how to enter names, see
“Entering Characters Using the Number Keypad” on
page 1.38.

Or,

If you do not want to assign a name, skip this step.

Press Enter when the name appears correctly or simply
without entering a name.
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5 To store more telephone numbers, press another one-
touch button and repeat steps 2 through 4.

Or

To return to Standby mode, press Cancel/Reset.

Sending a Fax using a One-Touch Number

1 Load the document(s) face down into the ADF.
“"DOCUMENT READY” appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press the one-touch button where you stored a number.

4 Ppress Start FAX Black to send a black and white fax or
Start FAX Color to send a colour fax.

The fax number stored in the one-touch dial location will
be automatically dialled, and the document will be sent
when the remote fax machine answers.

Speed Dialling

You can store up to 90 numbers in the 2-digit Speed Dial
locations (01-90).

Storing a Number for Speed Dialling
1 Press and hold Speed for 2 seconds.

2 Enter a speed dial number using the number keypad
and then press Enter.

If a number is already stored in the location you chose,
the display shows the number. To replace the number
with other phone number, select "1.RENEW". Otherwise,
select "2.0THER” and start over with a different speed
dial number.
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Enter the number you want to store, and press Enter.

To assign a name to the number, enter the desired
name. For details on how to enter names, see “Entering
Characters Using the Number Keypad” on page 1.38.

Or

If you do not want to assign a name, skip this step.

Press Enter when the name appears correctly or simply
without entering a name.

To store more telephone numbers, repeat steps 2
through 5.

Or

To return to Standby mode, press Cancel/Reset.

Sending a Fax using a Speed Dial Number

1

Load the document(s) face down into the document
feeder. "DOCUMENT READY" appears in the display.

You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

Press Speed.

Enter the speed dial number using the number keypad.

You can scroll through the numbers stored in memory
by using the Scroll buttons (< or »).

When the desired number appears in the display, press
Enter.

Press Start FAX Black to send a black and white fax or
Start FAX Color to send a colour fax.

The fax number stored in the speed dial location will be
automatically dialled and the document will be sent
when the remote fax machine answers.
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Group Dialling

If you frequently send the same document to several
destinations, you can create a group of these destinations
and set them under a one-touch button. This enables you to
press a single one-touch button to send the same document
to all the destinations in the group.

gNOTE: You can only group numbers that have already been
registered for speed dialling.

Setting Group Dial

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press the Scroll buttons (<€ or ») until you see
“6.GROUP SET” and then press Enter. The display
prompts you to select a one-touch button.

3  Press the one-touch button under which you want to
register the group and then press Enter.

g NoOTE: If the one-touch button has already been registered for
one-touch dialling or another group, the display prompts you to
renew the selected one-touch button or select another one-
touch button. Select "1:RENEW” to delete the contents in the
selected one-touch button and continue, or "2:0THER” to keep
the the contents and start over with a different one-touch
button.

4 The selected group number appears in the display and
the display prompts you to confirm the number. Press
Enter to accept “1:YES". If you select "2:NO", the
selected one-touch button will be cancelled and you can
start over with another one-touch group number.

5 The display prompts you to enter a speed dial number.
Enter the 2-digit speed dial number you want to include
in the group and then press Enter.
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6 Repeat step 5 to enter another speed dial number into
the group.

7 When you have entered all the desired numbers, press
Cancel/Reset. The display prompts you to enter a
name.

8 If you want to assign a name to the group, enter the
desired name.

Or, skip this step.

9 Press Enter after you enter the name or without
entering the name.

10 1f you want to assign another group, repeat from step 3.

To return to Standby mode, press Cancel/Reset.

Sending a Fax Using Group Dialling
(Multi-Address Transmission)

You can use Group Dialling for broadcasting, delayed fax, or
toll save transmission.

Follow the procedure of the desired operation (broadcasting
- page 5.28, delayed fax - page 5.29, toll save transmission
- page 5.12). When you come to a step in which the display
requests you to enter the remote fax number, press the one-
touch button assigned to a group. You can use only one group
number for one operation. Then continue the procedure to
complete the desired operation.

Your product automatically scans the document loaded in the
document tray into the memory, and the product will dial
each of the numbers included in the Group.
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Searching for a Number in the
Memory

There are two ways to search for a number in the memory.
You can either scan from A to Z sequentially, or you can
search using the first letter of the name associated with the
number.

Searching Sequentially through the
Memory

1 Press Search/Delete.

2 Press the Scroll buttons (<€ or ») to scroll through the
memory until you see the name and number you want
to dial. You can search downward or upward through the
entire memory in alphabetical order (from A to Z).

While searching through the product’s memory, you will
see that each entry is preceded by one of three letters:
“T” for one-touch dial, “S” for speed, or “G” for group
dial number. These letters tell you how the number is
stored.

3 When the name and number you want appears on the
display, press Enter to dial.

Searching with a Particular First Letter

1 Press Search/Delete.
2 Press the button labelled with the letter you want to

search for. A name beginning with the letter appears on
the display.

For example, if you want to find the name ‘MOBILE’,
press the 6 button, which is labelled with ‘"MNO.’

3 Press the Scroll buttons (<€ or P) to display the next
name in the list.

4 When the name and number you want appear, press

Enter to dial.
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Advanced Faxing

Broadcasting

Documents are automatically stored in memory and sent to
a remote station. Use this feature to send your documents to
multiple locations. After sending, the documents are
automatically erased from the memory.

d NOTE: You can not use colour mode in broadcast mode.

=

Load the document(s) face down into the document
feeder. "DOCUMENT READY" appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press Setup.

4 Press the Scroll buttons (<€ or ») until you see
“4.ADVANCED FAX" and then press Enter.

5 The display shows the first menu "BRAODCASTING".
Press Enter.

6 Enter the phone number of the remote fax machine
using the number keypad.

You can also use a one-touch button or press Speed
then use a 2-digit speed dial number.

7 Press Enter to confirm the number. The display asks

you to enter another fax number to send the document
too.

8 Select “1.YES” by pressing 1 and repeat from step 6 to
enter another fax number.

Note that you cannot use Group dial numbers for
another fax number.
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9 To send to one location or when you complete the last
fax number setting, press 2 to select "2.NO" in the
“ANOTHER FAX NO.?" screen.

10 The document(s) will be scanned into the memory
before transmission.

The display shows the memory capacity and the number
of pages being stored in the memory and then the
product begins sending the document in order you
entered the numbers.

Delayed Fax

You can set your product to send a fax at a later time, for
example when you will not be there.

g NOTE: You can not use colour mode for delayed faxing.

=

Load the document(s) face down into the document
feeder. "DOCUMENT READY" appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press Setup.

4 Press the Scroll buttons (<€ or ») until you find
“4.ADVANCED FAX" and then press Enter.

5 Press the Scroll buttons (<€ or ) until you see
“DELAYED FAX" and then press Enter.

6 Enter the phone number of the remote fax machine
using the number keypad.

You can also use a one-touch button or press Speed
then use a 2-digit speed dial number.
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7 Press Enter to confirm the number. The display asks

you to enter another fax number to send the document
too.

8 Select “1.YES” by pressing 1, and repeat from step 6 to
enter another fax number.

Note that you cannot use Group dial nhumbers for
another fax number.

9 To send to one location or when you complete the last

fax number setting, press 2 to select "2.NO" in the
“"ANOTHER FAX NO.?” screen.

10 The display asks you to enter a name. If you want to
assign a name to the transmission, enter the name. If
not, skip over this step.

For details on how to enter the name using the number
keypad, see “Entering Characters Using the Number
Keypad” on page 1.38.

11 Press Enter. The display shows the current time and

asks you to enter the start time when the fax is to be
sent.

12 Enter the time by using the number keypad.

If you set a time earlier than the current time, the
document will be sent at that time on the following day.

13 Press Enter when the start time on the display is
correctly.

14 The document will be scanned into the memory before
transmission.

The display shows the memory capacity and the number
of pages being stored in the memory.

The product returns to Standby mode and the display
reminds you that you are in Standby mode and that
Delayed Transmission is set.

d NOTE: If you want to cancel the Delayed Fax, see “Cancelling a

Scheduled Operation” on page 5.35.
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Priority Fax

When priority sending is enabled, a high priority document
can be transmitted ahead of reserved operations. The
document is scanned into the memory, then transmitted
when the current operation is concluded. In addition, the
Priority Send will interrupt a broadcast operation between
stations (i.e., when transmission to station A ends, before
transmission to station B begins) or between redial attempts.

d NOTE: You cannot use colour mode for priority faxing.

=

Load the document(s) face down into the document
feeder. "DOCUMENT READY" appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press Setup.

4 Press the Scroll buttons (<€ or ») until you see
“4.ADVANCED FAX" and then press Enter.

5 Press the Scroll buttons (<€ or ) until you see
“PRIORITY FAX" and then press Enter.

6 Enter the phone number of the remote fax machine
using the number keypad.

You can also use a one-touch button or press Speed
then use a 2-digit speed dial number.

7 Press Enter to confirm the number. The display asks
you to enter a name.

8 If you want to assign a name to the transmission, enter
the name. If not, skip over this step.

For details on how to enter a name using the number
keypad, see “Entering Characters Using the Number
Keypad” on page 1.38.
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9 Press Enter. The document(s) will be scanned into the
memory before transmission.

The display shows the memory capacity and the number
of pages being stored in the memory.

10 The product shows the number being dialled and then
begins sending the document.

Polling

Polling is used when one fax machine requests another to
send a document. This is useful when the person with the
original document to be sent is not in the office. The person
who wants to receive the document calls the fax machine
holding the original and requests that the document be sent.
In other words, it “polls” the machine holding the original.

Polling Transmission

You can program your product to send documents in your
absence when polled by a remote fax machine. It is possible
to use a poll code to prevent unauthorized polling of your
product. When you secure your product in this manner, only
those who know the poll code can poll your product.

NOTE: You cannot use colour mode for polling transmission.

=

Load the document(s) face down into the document
feeder. "DOCUMENT READY" appears in the display.

2 You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

3 Press Setup.

4 Press the Scroll buttons (<€ or ») until you see
“4.ADVANCED FAX" and then press Enter.
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5 Press the Scroll buttons (<€ or ») until you find “SEND
POLLING”, and then press Enter.

The display asks you to enter a 4-digit poll code. The
poll code is preset to "0000"” at the factory, which
represents no poll code.

6 If you want to use a poll code, enter the desired 4-digit
code (except for "0000”) and then press Enter.

Or

If you do not want to secure the transmission with a poll
code, press Enter when the display shows “"0000” for
the poll code, or enter 0000.

7 The product stores the document in the memory. The
display counts the number of pages being stored in the
memory and the memory capacity remaining.

The product returns to Standby mode and the display
shows a reminder that "POLL TX" is set.

NOTE: If you have previously set the receive mode to other
than FAX mode, the product automatically switches to FAX
mode (automatic receiving) when set to be polled.

Polling a Remote Machine

Your product will poll a remote fax machine and retrieve a
document, which is stored in memory and then print it.

1 Lift the handset or press OHD/V.Req on the front
panel, and enter the phone number of the remote fax
machine.

2 When you hear a fax tone from the remote machine,
press Setup.

3 When the display shows “"TO RX POLL PRESS ENTER”,
Press Enter.

The display asks you to enter a 4-digit poll code. The
poll code is preset to "0000” at factory. 0000 represents
no code.
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If the remote machine is secured with a Poll code, you
must enter the correct code and then press Enter.

Or

If the remote machine is not secured with a Poll code,
just press Enter to accept “0000".

Your product starts to receive the document from the
remote fax machine.

Adding Documents To a Scheduled
Operation

You can add documents to a transmission previously
reserved in your product's memory.

1

Load the document(s) face down into the document
feeder. "DOCUMENT READY” appears in the display.

You can adjust the resolution and the contrast to suit
your fax needs. For details, see page 5.3.

Press Setup.

Press the Scroll buttons (<€ or ) until you see
“4.ADVANCED FAX" and then press Enter.

Press the Scroll buttons (<€ or ) until you see “"ADD
SCHEDULE" and then press Enter.

Press the Scroll buttons (< or ») repeatedly until you

see the operation to which you want to add documents
on the display, then press Enter.

The product automatically stores the documents in the
memory, and the display shows the memory capacity
and the number of pages.

After storing, the product displays the number of total
pages and then returns to Standby mode.
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Cancelling a Scheduled Operation

1 Press Setup.

2 Press the Scroll buttons (<€ or ») until you see
“4.ADVANCED FAX" and then press Enter.

3 Press the Scroll buttons (<€ or »)until you find
“CANCEL SCHEDULE", and then press Enter.

4 Press the Scroll buttons (<€ or ») repeatedly until you
find the operation you want to cancel and then press
Enter.

5 The selected job is cancelled and the display returns to
Standby mode.
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Additional Feature

Printing Reports

Your product can print reports containing useful information
- Schedule Job, System Data, etc. The following reports are
available:

Help List

This list shows the product’s basic functions and commands
to use as a quick reference guide.

Sent Journal

This report shows information concerning transmission
activities recently made.

Received Journal

This report shows information concerning reception activities
recently made.

Phonebook

This list shows all of the numbers currently stored in the
product’s memory as one-touch dial numbers, speed dial
numbers and group dial numbers.

Sending Confirmation

This report shows the fax number, the humber of pages,
elapsed time of the operation, the communication mode, and
the communication results.

You can set up your product to print the message
confirmation report in one of the following ways:

e Automatically after each transmission (ON)
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e Automatically only if an error occurs during transmission
(ERR)

¢ No report printed at all (OFF). You can print this report
manually at any time you want.

Schedule Job Information

This list shows the document currently stored for Delayed
Sending, Priority Sending, Group Sending, and TX polling.
The list shows the starting time, type of operation, etc.

System Data List

This list shows the status of System Setup, Fax Setup, and
Copy Setup options. After you change any setting, print this
list to confirm your changes.

Self Test Page

This page shows the pattern indicating the status of the
cartridge nozzle. You can check if the product is printing
correctly using this page.

CID (Caller Identification) List

This list shows 30 last numbers you received if you have the
Line Identification Service from the network. You can check
the phone number of the caller and the date and time when
the call was received.

Junk Fax List

This list shows the fax numbers defined as junk fax numbers
by using the Junk Fax Setup menu (see page 5.43). When the
Junk Fax Barrier feature is turned on, the incoming faxes
from those numbers will be blocked.

print out when there is no paper loaded or a paper jam has

g NOTE: The list you have set to print out automatically will not
occurred.

Other Reports

¢ Multi-Communication Report: This report is printed
automatically after sending documents to more than one
location.
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e Power Failure Report: This report is printed out
automatically when power is restored after a power failure
if there occurs any data loss due to the power failure.

Printing List
1 Press Setup.

2 Press the Scroll buttons (<€ or ) repeatedly until you
see “5.REPORT/HELP”, and press Enter.

3 Press the Scroll buttons (< or ») repeatedly until you
find the list you want to print.

4 When the desired list displays, press Enter. The
selected list will be printed.

Fax Setup Options

Your product has various user-selectable setup options for
the fax system. These options are preset at the factory, but
you may need to change them. To find out how the options
are currently set, print the System Data list. For details on
printing the list, see above.

Setting an Option
1 Press Setup.

2 Press the Scroll buttons (<€ or P) until you see “2.FAX
SETUP” and then press Enter.

3 The display shows the first setup option “SEND FROM
MEMORY". Scroll through the options by pressing the
Scroll buttons (<« or »).

4 When you see the option you want on the display, press
Enter.
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5 Choose the desired status by pressing the Scroll

buttons (< or B) or enter the desire number using the
number keypad.

6 Press Enter to save the selection.

7 Repeat from step 1 to set other data options if
necessary. You can exit from setup mode at any time by
pressing Cancel/Reset.

Selectable Options

These instructions assume you‘ve followed the steps under
“Setting an Option” on page 5.38 and the product is
prompting you to change one of the options listed here.

e SEND FROM MEMORY : If you are annoyed that you
have to wait until documents in the ADF are sent out when
you try to send or reserve another fax, turn this feature on.
With this feature enabled, all transmission documents are
automatically scanned into memory before transmission.

Select ON to turn this feature on. Note that this feature will
be disabled for colour faxing.
Select OFF to turn this feature off.

SENDING CONFIRM : A message confirmation report
shows whether the transmission was successful or not, how
many pages were sent, etc.

Select ON to print a confirmation report automatically each
time you send a fax.

Select OFF to turn this feature off.

Select ERROR to print only when an error occurs and the
transmission was not successful.

e FAX PAPER SIZE : Select the paper size you will use for
the recording paper. Sizes available are: LETTER, A4.
LEGAL.
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e AUTO REDUCTION: When receiving a document as long
or longer than the paper loaded in your product, the
product can reduce the received data to fit into your

recording paper size.
/

Original Received data

Turn this feature on to reduce an incoming page that may
need to be divided into two pages with only a few lines on
the second page. If the product cannot reduce the data to
fit onto one page with this feature enabled, the data will be
divided and printed in actual size on two or more sheets if
necessary.

Select ON to enable. Note that this feature does not apply
in copy mode.

Select OFF to turn this feature off. The overflow data will be
discarded or printed out on a second page depending on the
discard size setting (see page 1.40).

SAVE TOLL TIME: You can set the start time for toll save
transmission using the SAVE Toll button. For details on
toll save transmission, see page 5.12.

Enter the desired time using the number keypad. You can
toggle between AM and PM by pressing the Scroll buttons
(<€ or ») repeatedly in 12-hour mode.

¢ RINGS TO ANSWER : You can select the number of times

your product rings before answering an incoming call.

Enter a number using the number keypad.

e REDIAL INTERVAL : Your product automatically redials

a remote fax machine if it was busy or does not answer on
the first call.

Enter the number of minutes using the number keypad.
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e REDIAL COUNT: Enter the number of attempts made
to redial a number.

If you enter 0, the product will not redial.

e STAMP RCV. NAME : Allows the product to automatically
print the page number, and the date and time of the
reception at the bottom of each page of a received
document.

Select ON to turn this feature on.
Select OFF to turn this feature off.

RCV. START CODE : The remote receive code allows you
to initiate fax reception from an extension phone plugged
into the EXT jack. If you pick up the extension phone and
hear fax tones, enter the remote receive code and the fax
will start receiving. The password is preset to * 9* at the
factory.

Enter the desired code from 0 to 9 on the number keypad.

DRPD (Distinctive Ring Pattern Detection) MODE :
‘Distinctive Ring’ is a telephone company service which
enables a user to use a single telephone line to answer
several different telephone numbers. The particular
number someone uses to call you on is identified by
different ringing patterns, which consist of various
combinations of long and short ringing sounds. This feature
is often used by answering services who answer telephones
for many different clients and need to know which number
someone is calling in on to properly answer the phone.

Using the Distinctive Ring Pattern Detection feature, your
product can ‘learn’ the ring pattern you designate to be
answered by the SF-430 product. Unless you change it, this
ringing pattern will continue to be recognized and answered
as a FAX call, and all other ringing patterns will be
forwarded to the extension telephone or answering product
plugged into the EXT jack. You can easily suspend or
change Distinctive Ring Pattern Detection at any time.
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o

Before using the Distinctive Ring Pattern Detection option,
Distinctive Ring services must be enabled on your
telephone line by the telephone company. To setup
Distinctive Ring Pattern Detection, you will need another
telephone line at your location, or someone available to dial
your fax number from outside.

Select ON to turn this mode on.

Select OFF to turn this mode off.

Select SET to setup the Distinctive Ring Pattern Detection.
The LCD displays "WAITING RING". Call your fax number
from another telephone. When the product completes
‘learning’, the LCD displays "END DRPD SETUP”.

With the DRPD feature active, "\DRPD MODE" appears in the
display and the previously set reception mode is ignored. If
you turn DRPD off, the product returns to the previously set
reception mode.

NOTES:

DRPD must be set up again if you re-assign your fax number,
or connect the product to another telephone line.

After DRPD has been set up, call your fax humber again to
verify that the product answers with a fax tone, then have a
call placed to a different number assigned to that same line to
be sure the call is forwarded to the extension telephone or
answering product plugged into the EXT jack.

ECM MODE (Error Correction Mode) : This mode
compensates for poor line quality and ensures accurate,
error-free transmission with any other ECM-equipped
facsimile machine. If the line quality is poor, transmission
time may be increased when ECM is enabled.

Select ON to turn the Error Correction mode on.
Select OFF to turn this Error Correction mode off.

AUTO JOURNAL : A journal shows specific information
concerning transmission or reception activities, the time
and dates of up to 40 most recent transmissions or
receptions.

Select ON to print the journal automatically after every 40
transmissions or receptions.
Select OFF to print the journal manually.
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e CALLER ID : When you receive a call, you can see the
number of the person calling you if you have Caller Line
Identification Service from the network. (This option may
not work when connected to a PABX.)

Select ON to display the caller ID.
Select OFF not to display the caller ID.

NOTE: The Caller ID option may be unavailable depending on
your area or country.

¢ JUNK FAX BARRIER: With this feature set to ON, the
system will not accept a fax sent from a remote station
who's fax number is stored in memory as a junk fax
number via the Junk Fax Setup menu below.

Select ON to turn this feature on. You can not receive from
stations identified as junk fax numbers.

Select OFF to turn this feature off. Anybody can send you a
fax.

¢ JUNK FAX SETUP : You can register up to 20 desired fax
numbers from the CID (Caller Identification) list as junk fax
numbers. When the Junk Fax Barrier feature is turned on,
the incoming faxes from those numbers will be blocked.

Select REGISTER to register a junk fax number. Press the
Scroll buttons (< or ») to scroll through the CID list, and
press Enter when the desired number is displayed.
Select DELETE to delete a registered junk fax number. Press
the Scroll buttons (<« or ) to scroll through the list and
press Enter when the desired number is displayed.
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Using the Fax Settings Utility

When you install the MFP driver, the Fax Settings Utility is
automatically installed. With this program, you can configure
the various fax setup options and store speed dial numbers
from your computer. You can download this information to
your SF-430 to make them effective on the front panel.

To install the MFP driver, see “Installing Samsung Software”
on page 1.21.

Accessing the Fax Settings Utility

1 Click Start > Programs> SAMSUNG SF-430 Series>

Fax Settings Utility.
[i_l Favorites » S Epson 4
@HP Desklet 830C Series v11.1 ¥
@ Documents 4 @ Internet E xplorer 4
@ Online Services L4
I% Seftings ¥ [ 5amsung SC%-1100 Series 4
_ @ Samsung SCx-1150 Senies L4
% (e '8 B ) Fax Settings Uity
@ Help @StartUp L4 @Printer Contral Program
- @Xerox workCentre Pro 412 L4 @ Frinter Driver ReadMe
. #3-D0S Prompt (5 5F-430 Series Uninstall

4 TWAIN Driver Help
57 TWAIN Driver Uninstaller

3] windows Explorer

dowsO8

& Log Off Buririug...

A In case of Windows 98

2 The Samsung SF-430 Fax Settings Utility dialogue box
opens.

% Samsung SF-430 Fax Settings Utility P S |

Selings | Phonebook | About |

i~ Teminal ID

Fax Mame: |F54

Fax Mumber.  |123456799
- Fax Setting:

Fieceive Made:  [Fd - Sending Corfimaion. [y =]
Fax Paper Size: a4 B Remote Receive Code: [«ge -

Auto Reduction: | In

Discard Size: 13 =
[ — | tnes P Enor Conestion Mode
RediglCourt: |5 = fmes I Stamp Receive Name

RedialInterval 12 = min Send Defauits
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3 After using the Fax Settings Utility, click Exit to close
the dialogue box.

You can get online help by clicking the Help button.

Settings Tab

Using the Settings tab, you can set up the fax name and
number, and configure the fax setup options. For details on
each setup option, see “Fax Setup Options” on page 5.38.

?0 Samsung 5F-430 Fax Settings Utility

Settings | Phonebookl About I

— Teminal 1D

Fax Mame: IFar{

Fa Nurmber: |1 23456789

— Fax Sefting:
Receive Mode: Fi A Sending Confirmation: m
Fax Paper Size: Ad = Remote Receive Code: IxSx vl
Auto Reduction:  |0n i
Dizcard Size: I‘I 5 ﬂ 00w
Rings to Answer: |1 jl times ¥ Enor Comrection Mode
Fiedial Count: |5 :II times ™ Stamp Receive Name
Redial Interval: I3 j min Send | Defaults |

E it I Help |

When configuration is complete, click Send to download the
information to SF-430.

The Defaults button allows you to restore the default status
of each item.
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Phonebook Tab

Using the Phonebook tab, you can store speed dial
numbers (for details on speed dialling, see page 5.23).

fv" Samsung 5F-430 Fax 5Settings Utility

Seftings  Phonehook |About |

T
5 Get Phonebook, |

& Speed dial [1~90)
Send Phonebook. |

Mo, Name Phone number [P: Pause]

1 Samsung 0312004099

i Z Hansem 0352637522

0@ -1 e

Edit | Delete | Delete Al |

Exit I Help |

e Get Phonebook: gets the speed dial numbers stored in
the memory of your product.

¢ Send Phonebook: sends the speed dial numbers to your
product. After storing or deleting a speed dial number, you
must click this button to make the changes effective on the
front panel of your product.

¢ Edit: allows you to store or edit a speed dial number. After
selecting the desired speed dial location from the list, click
this button. Then, enter a name and number in the Edit -
Speed dial #X dialogue box (where X designates the
selected speed dial location), and click OK to save.

e Delete: deletes the selected speed dial number.

e Delete All: deletes all the speed dial numbers.

About Tab

The About tab gives you the program version number. If you
click on the globe image on the bottom of the window, you
will be connected to the Samsung web site provided you are
on the internet.
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MAINTENANCE

This chapter provides suggestions for high-quality and
economical printing and information for maintaining the
print cartridges and the product.

This chapter includes:

e Maintaining Print Cartridges

e Viewing Ink Levels

e Cleaning the Print Cartridges

e Replacing the Print Cartridges

e Aligning the Print Cartridges

e Clearing Memory

e Adjusting Shading

e Setting the Product to be Checked by Phone

e Cleaning the Document Scanner
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Maintaining Print Cartridges

To get the maximum benefit from your print cartridges:

¢ Do not remove a print cartridge from its packaging until you
are ready to install it.

Do not refill the print cartridges. The warranty does not
cover damage caused by using refilled cartridges.

Store the print cartridges in the same environment as your
equipment.

Do not remove a print cartridge from the product except to
replace, or clean. Immediately replace the print cartridge

or store in the storage unit. The print cartridge will not print
correctly if removed from your product and left exposed for
an extended period of time.

Your product will not print with only one print cartridge
installed. If you do not have a new replacement for the
empty print cartridge, leave the empty cartridge in the
cartridge holder of the product.

Do not swap the colour cartridge with the black cartridge.
The colour cartridge should be installed in the Left carrier
and the black cartridge should be installed in the Right
carrier.

If you have an opened ink cartridge you are not currently
using and do not have an available print cartridge storage
unit, store it in an airtight plastic bag. Do not leave it
exposed to the air for an extended period; this promotes
drying out and clogging of the print nozzles.
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Viewing Ink Levels

You can view the ink level on the LCD display using the front
panel buttons. Take the following steps:

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press the Scroll buttons (<€ or ») until you see
“8.MAINTENANCE" and then press Enter.

3 Press the Scroll buttons (<€ or ) until you see “VIEW
INK LEVEL" on the display and then press Enter.

4 The colour ink level and the black (or photo) ink level
are displayed. The remaining ink is displayed as a
fraction of the full capacity.

COLOR & 7
BLACK : §
|
|

=
7] %

nk Fulll capacity

Remaining

Cleaning the Print Cartridges

Cleaning your print cartridges can improve the quality of
printing. If your printed page is missing lines or dots or
contains ink streaks, clean the print cartridges as described

in this section.

There are two methods to clean the print cartridges:

¢ Printing a head cleaning page, which can be done from the
front panel of the SF-430 or from the Control Program on
your computer screen.

¢ Clean the print cartridge nozzles.

NOTE: Do not clean the print cartridges unnecessarily, as this
wastes ink and shortens the life of the print cartridge.

MAINTENANCE m
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Printing a Cleaning Page from the SF-430

1

Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

Press the Scroll buttons (< or ) until you find
“8.MAINTENANCE" on the display, and press Enter.

The first maintenance option "CLEAN CARTRIDGES”
appears on the bottom line of the display.

Press Enter to start the cleaning process. Your product
prints a cartridge cleaning page.

Examine the cleaning pattern. Compare the diagonal
lines at the top and bottom of the test pattern.

A broken line shows any clogged nozzles. If the bottom
line shows improvement, rerun this cleaning process
two more times.

—— Before purge

Il

Purge process

Z

o«——After purge

If this process does not improve the print quality, your
print cartridges may be low in ink. Replace the print
cartridge, if necessary.

If the line is still broken, clean the print nozzles. See
“Cleaning the Print Cartridge Nozzles” on page 6.6.
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Printing a Cleaning Page from Your
Computer

1 Click Start > Programs > Samsung SF-430 Series

> Printer Control Program.

@ Online Services

@ Settings
% Find
@ bep
Bur...

& Log Off Buririug...

A In case of Windows 98

Bz 5amsung SF B3
@ StartUp

@Xerox workCentre Pra 41
MS-D0S Prampt

3] windows Explorer

dowsO8

#* | Favorites » F1Epson
@HP Desklet 830C Senies v11.1
@ Documents 4 @Intemet Explarer

’ @ Samsung SCx-1100 Senies
@ Samsung SCx-1150 Senies
3

* ¥ v v v ¥

& Fax Settings Uity
L4 Cﬁ Frinter Control Program

2 L4 @ Frinter Driver ReadMe

(5 SF-430 Series Urinstal

4 TWAIN Driver Help

57 TWAIN Driver Uninstaller

2 The Samsung SF-430 Series Control Program dialogue
box appears. Select the Cartridges tab.

&% Samsung 5F-430 Series Control Program on LPT1:

Statusl Options
Ink Level

i

Order Supplies!

Inztall/Change Cartidge |
Clean Print Mozzles |
Align Cartridges |

I [ =

Cloze

| Help

A In case of Windows 98

NOTE: In Windows 2000/XP, the Printer Control Program is
unavailable. But, you can access the Cartridge Maintenance
features through the printer properties by taking the following
steps:
Click Start > Settings > Printers.

Right-click on the Samsung SCX-1150 Series printer in

1.
2.

3.
. Click the Cartridge Maintenance tab.

the Printers folder.

From the pop-up list, select Properties.

MAINTENANCE m
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3 Click Clean Print Nozzles from the Cartridges tab.

4 The product feeds a sheet of paper and prints a cleaning
pattern. Examine the cleaning pattern. Refer to step 5
under “Printing a Cleaning Page from the SF-430” on
page 6.4.

Cleaning the Print Cartridge Nozzles

If print quality does not improve after repeatedly printing the
cleaning page, the problem may be caused by dried ink on
the print cartridges.

1 Lift the front panel and open the top cover.

2 After the print cartridges have moved to the centre of
the product, unplug the power cord from the back of
your product.

3 Pull the print cartridge(s) towards you until you hear a
click and remove the cartridge(s).
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NOTES:

e Keep new and used print cartridges out of the reach of
children.

¢ Be careful not to touch the ink nozzles or the electrical
contacts. Touching these parts of the print cartridge can
result in clogs, ink failure, or a bad electrical connection.

4 Use a clean cloth, dampened with water only, to gently
clean the entire copper coloured area, including the
nozzles and contacts.

To dissolve any dried ink, place the cartridge on a heavy
damp cloth as shown below and push the cartridge with
light pressure to let the nozzles come in contact with the
cloth for about three seconds. Then gently blot and wipe
dry.

If you are cleaning a colour print cartridge, be especially
careful to wipe the nozzles in only one direction so the
colours do not mix.

-

Nozzles

Contact area

MAINTENANCE m
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5 Allow the copper-coloured area to dry.

6 Reinstall the print cartridges and close the top cover.
Then, plug the power cord in to turn the product on.

7 Print a cleaning page and examine the cleaning pattern.
If the line is still broken, clean the print cartridge holder
contacts in your product.

NOTE: Once the cartridges are removed and installed,
cartridge alignment may be required. After you clean the
cartridge, if necessary, align the cartridges.
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Cleaning the Cartridge Holder Contacts

1 Open the front panel and the top cover. The print
cartridges move to the centre of the printer.

2 Unplug the power cord from the electrical outlet or the
rear of the product.

3 Remove the print cartridges.

4 Use a CLEAN, DRY CLOTH to clean the print cartridge
holder contacts inside the printer.

Cartridge
holder
contact

5 Install the print cartridges, and close the top cover and
the front panel.

Then plug the power cord in.

MAINTENANCE m
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Replacing the Print Cartridges

Your product is a dual cartridge inkjet printer. You must use
a black (or photo) and a colour ink cartridge.

There are two types of black and colour cartridges: Standard
and high yield. Before proceeding to install, you need to
check which cartridge type you have. When you install the
cartridges, you will be asked if it is Standard or High Yield. In
order to find out the type, match the part number on the
cartridge with the table below.

Cartridge type Part number

High yield | Lexmark 12A1975

Black cartridge Samsung INK-M50
Standard
Lexmark 12A1970

High yield | Lexmark 15M0125

Colour cartridge Samsung INK-C60
Standard
Lexmark 15M0120

Photo cartridge Lexmark 12A1990

When you notice the print becomes light or "CHANGE XXXXX
INK” (where XXXXX designates the empty cartridge) appears
in the display, replace the appropriate cartridge(s).

The print cartridge includes the ink supply and the print head.
Each time you replace the ink cartridge you are replacing the
print head as well.

Replacement of the print cartridges can be done from the
front panel of your product or from the computer using the
Samsung SF-430 Series Control Program.
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Replacing Print Cartridges from the SF-430

1 Carefully unwrap the new ink cartridge(s) and remove
the sealing tape by slowly pulling it in a straight out
motion.

NOTE: Avoid touching the electrical contacts on the cartridge.
Ensure that there are no pieces of tape remaining on the

cartridge.

2 Lift the front panel by grabbing the panel along the top
edge and pulling it towards you.

3 Open the top cover. The print cartridge holder moves to
the centre position.

MAINTENANCE m
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4 Locate the print cartridge holder inside the product. The
black (or photo) ink cartridge holder is located on the
right and the colour ink cartridge is on the left.

Colour ink
cartridge

Black (or photo)
ink cartridge

&

5 Pull the old cartridge(s) towards you until you hear a
click and then remove the cartridge(s) from the holder.

6 Place the new print cartridge(s) into the holder and push
it forwards until it clicks into place.

NoTEs: If the display shows "REMOVE PAPER JAM AND PRESS
CANCEL"” when you have closed the front panel, re-install the
cartridge(s). With the print cartridge(s) installed improperly,
the product might not print.

7 Close the top cover and then the front panel. The
display prompts you to confirm the changed
cartridge(s).

You can choose from LEFT, RIGHT or BOTH by using the

Scroll buttons (< or ). Press Enter when your
choice appears in the display.
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8 The display prompts you to confirm a new or an old

cartridge. Press the Scroll buttons (< or ») to scroll
through the options and press Enter when your choice
appears in the display.

The available options for the right cartridge are: NEW
BLACK, OLD BLACK, NEW PHOTO, and OLD PHOTO. If
you installed a photo cartridge instead of a black
cartridge, select "NEW PHOTO"” or “OLD PHOTO".

The available options for the left cartridge are: NEW
COLOR and OLD COLOR.

NOTES:

e With the photo cartridge installed, only PC printing is
available.

e If you reinstall the printer driver or replace a print cartridge
with an old cartridge, the ink level on the Printer Control
Program may be incorrect even when you do not change the
cartridges.

9 The display prompts you to confirm the cartridge
capacity: Standard or HIgh Yield. Use the Scroll

buttons (< or ») to scroll through the options and
press Enter when your choice appears in the display.

If you have installed a photo cartridge, you don’t have
to select the capacity of the photo cartridge because
your product supports only a standard photo cartridge.

NOTE: If you make a mistake when you confirm the cartridge
capacity, the ink level shown in the Printer Control Program
may not be correct.

MAINTENANCE @
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10 When you have finished setting the cartridge(s) and if
any new cartridges were installed, the cartridge
alignment procedure begins automatically by printing
the Cartridge Alignment form.

Refer to step 4 under “Aligning the Print Cartridges” on
page 6.16.

If you installed an old cartridge, the product returns to
Standby mode without printing an Cartridge Alignment
form.

CAUTION: Do not power off the product until the Cartridge
Carrier Assembly has moved back into the home position. If no
menu choices are made, the Carrier Assembly will
automatically return to the home position after about one
minute.

Replacing Print Cartridges from the
Control Program

1 Click Start > Programs > Samsung SF-430 Series
> Printer Control Program. You have accessed the
Samsung SF-430 Series Control program.

2 Select the Cartridges tab.

3 Click Install/Change Cartridge from the Cartridge
tab. The cartridge holder moves to the centre position.

4 Lift the front panel by grabbing the panel along the top
edge and open the top cover. Replace the old
cartridge(s) by following the instructions on page 6.11.
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5 After installing, click the appropriate buttons in the
Samsung SF-430 Series dialogue box to indicate the
type of the cartridge(s) you have installed.

Samsung SF-430 Series [ ]

Open the printer front cover and replace the print
cartridge. Pleasze verify the zettings below, then

chick Ok
" Left Carriage " Right Carriage
Y_IJLL? | | ||
Color Black Photo

" New INK-M50(12A1970)¢" New 1241990

" New 15M0125 " New 12A1975 ¢~ 0Id Photo

" 0Id Color " 0Id Black
0K I Cancel

A 1n case of Windows 98

6 When you finish, click OK. If you have installed one or
both cartridges as new, the message dialogue box
appears to prompt you to align the cartridge. Click
Align.

7 Your product prints the Cartridge Alignment form.
Complete the alignment procedure by following the
instructions on page 6.18.

If you installed an old cartridge(s), the product returns
to Standby mode without printing the Cartridge
Alignment form.

g NOTE: In Windows 2000/XP, the Printer Control program is
unavailable. But, you can access the Cartridge Maintenance
features through the printer properties by taking the following
steps:

1. Click Start > Settings > Printers.

2. Right-click on the Samsung SF-430 Series printer in
the Printers folder.

3. From the pop-up list, select Properties.

4. Click the Cartridge Maintenance tab.

MAINTENANCE E
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Aligning the Print Cartridges

(* You must align the black and colour print cartridges after
installing new print cartridges or if the black portions of
? graphics do not align with the colour portions.

Cartridge alignment can be done from the computer using
the Samsung SF-430 Series Control Program or from the
front panel of the product.

Aligning Print Cartridges from the SF-430

1 Press Setup. The display shows “1.SYSTEM SETUP” on
the bottom line.

2 Press the Scroll buttons (<€ or ») until you find
“8.MAINTENANCE” on the bottom line and then press
Enter.

3 Press the Scroll buttons (<€ or ) until you see “ALIGN
CARTRIDGE" on the display and then press Enter to
start cartridge alignment.

4 The product feeds a sheet of paper and prints the
Cartridge Alignment form.

CARTRIDGE ALIGNMENT

ALIGNMENT A

ALIGNMENT C

LY |

012 9 10111213 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30

ALIGNMENT D

LI O B A
17 1819 20 21 22 23 24 25 26 27 28 29 30
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5 From each group on the form, locate the number under
the alignment pattern that comes closest to forming a
perfectly straight line.

6 The alignment entry menu appears on the display. The
letter on the right end of the display corresponds to the
alignment pattern. The range of numbers in the centre
of the display indicates the range of valid selection
choices. The flashing number on the left side of the
display indicates the line from the form that is currently
selected as optimal.

CARTREIDGE HAINT. ’

49 L[ey28l ]

Number Range

Last Alignment Alignments
Entry (A, B,C,D,EF)

7 Enter the number of the line which appears the
straightest from pattern A.

Press Enter to confirm your selection. The alignment
entry menu for the Alignment B pattern is displayed.

8 Repeat step 7 for Alignment test patterns B through F
(or D for the colour and the photo cartridges).

9 After you enter the number for the last group,
Alignment F (or D for the colour and the photo
cartridges), the display automatically returns to the
Standby mode.

Aligning Print Cartridges from the
Computer

1 Click Start > Programs > Samsung SF-430 Series
> Printer Control Program. You have accessed the
Samsung SF-430 Series Control program.

2 Select the Cartridges tab.

3 Click Align Cartridges from the Cartridge tab.

MAINTENANCE m
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4 The product feeds a sheet of paper and prints the
Cartridge Alignment form. The Align Cartridges dialogue
box appears.

Align Cartridges [ <]
| Info
1. The printer is Iy printing an ali t page. When it

iz finizhed, find the numIJml in each category that comes
clozest to forming a straight line.

2. Change the numbers below to the numbers you selected
from the printed page.

3. Click DK.
" A: Horizontal " B: Yertical
! E= .
LI

L

lack Bidi [Quick]
[

" D: Color Bidi [Quick]

B
i

=

" E: Black Bidi [Mormal) | F: Color Bidi [Mormal)

oF | s

Cancel |

A 1n case of Windows 98

5 Locate the number under each alignment group in the
pattern that comes closest to forming a perfect straight
line and enter the number of the line or click repeatedly
on the A or w button to select the number.

6 When the procedure is finished, click OK.

g NOTE: In Windows 2000/XP, the Printer Control program is
unavailable. But, you can access the Cartridge Maintenance
features through the printer properties by taking the following
steps:

1. Click Start > Settings > Printers.

2. Right-click on the Samsung SF-430 Series printer in
the Printers folder.

3. From the pop-up list, select Properties.

4. Click the Cartridge Maintenance tab..
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Clearing Memory

You can selectively clear information stored in your product’s
memory.

1 Press Setup.

2 Press the Scroll buttons (<€ or ») until you see “7.
MEMORY CLEAR” on the display and then press Enter.

3 Press the Scroll buttons (<€ or ») until you find the
item you want to clear. You can also enter the number of
the desired item.

e FAX NUMBER/NAME: your fax number and name
are cleared from memory.

e DIAL/SCHEDULE: clears the phonebook numbers,
one-touch, speed dial, or group dial numbers stored in
the memory. Also, all Schedule Job operations
reserved are cancelled.

¢ JOURNAL.: clears all records of transmissions and
receptions.

e DEFAULT SETUP: restores all settings to their
factory defaults.

4 Press Enter when your choice appears in the display.
The selected item is cleared.

5 Repeat steps 1 through 4 to clear another item.

MAINTENANCE @
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Adjusting Shading

If the scanning unit becomes dirty, it can alter the shading
value. If your print has black lines or is blurred, adjust the
shading setting. Take the following steps:

1 Load a sheet of white Letter-size paper into the
document feeder.

2 Press Setup.

3 Press the Scroll buttons (<€ or ») until you see
“8.MAINTENANCE" on the display and then press Enter.

4 Press the Scroll buttons (<€ or ®) until you see
“ADJUST SHADING"” on the display and then press
Enter.

NOTE: Do not remove paper from the document feeder while
adjusting.

Setting the Product to be Checked
by Phone

The Remote Test feature allows your product to be checked
out by a service company at a remote place by phone.

1 Press Setup.

2 Press the Scroll buttons (<€ or ») until you see
“8.MAINTENANCE" on the display and then press Enter.

3 Press the Scroll buttons (<€ or ») until you see
“"REMOTE TEST” on the display and then press Enter.

4 Press the Scroll buttons (<€ or ») to turn this feature
ON and then press Enter.

If you want to protect your product from being accessed
by unauthorised persons, select "OFF”.
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Cleaning the Document Scanner

To keep your product working properly, occasionally clean the
white roller, ADF rubber, and the scanning glass.

NOTE: Do not turn the power off to clean the scanner, as
documents stored in the memory will be lost.

1 Lift the front panel by grabbing the panel along the top
edge and pulling towards you.

2 Disassemble the white roller as follows:

Both ends of the white roller have plastic bushings that
are snapped shut with small tabs on them. Pull the
bushing on one end of the roller slightly inward (A),
then rotate the bushing until it reaches a slot (B). Pull
the roller upward.

Bushing

MAINTENANCE m
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3 Wipe the roller surface with a soft cloth dampened with
water.

=

4 Clean the ADF rubber piece.

5 cCarefully wipe the scanning glass with a soft, dry cloth.

If the glass is very dirty, first wipe it with a slightly
dampened cloth, then with a dry cloth. Be very careful
not to scratch the glass surface.

6 Replace the roller in reverse order, and then close the
front panel firmly until it clicks into place.

@ MAINTENANCE
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TROUBLESHOOTING

This chapter gives helpful information for what to do if you
encounter an error.

This chapter includes:

o Clearing Jams
o LCD Error Messages

o Fixing Problems
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Clearing Jams

Document Jams While Sending a Fax

If a document jams while you are sending it, 'DOCUMENT
JAM’ appears in the display. Do not pull the document out of
the slot. If you do this, it could harm your product.

1 Lift the front panel by grabbing the panel along the top
edge and pulling towards you.
o

N
\{ \'

o= =)

2 Carefully remove the jammed document.
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Paper Jams While the Product is Printing

If the paper jams while your product is printing, ‘REMOVE
PAPER JAM AND PRESS CANCEL ' appears in the display. Do
not pull it out. If you do, it could harm the product

If Jammed in the received paper output area:

2 Press Cancel/Reset to clear the message.

If jammed in the paper feed area:

1 Remove the jammed paper as shown below.

2 Press Cancel/Reset to clear the message.

3 After you have removed the jammed paper, load the
paper with the print side facing you.

Squeeze the left paper guide and move it to the right to

match the width of the paper.
TROUBLESHOOTING m
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If jammed inside the product:

1 Lift the front panel by grabbing the panel along the top
edge and pulling towards you.

4 Close the cover and the front panel.

5 Press Cancel/Reset to clear the message.
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Tips for Avoiding Paper Jams

By carefully selecting print materials and loading them
properly, you should be able to avoid most paper jams. If
jams do occur, follow the steps outlined in “*Clearing Jams” on
page 7.2. If jams occur frequently, make sure that you are
following these preventative tips:

¢ Follow the procedures in “Loading Paper” on page 1.11 to
load paper properly. Make sure that the adjustable guides
are positioned correctly.

¢ Do not overload the paper. Up to 100 sheets can be loaded
in the paper bin at a time.

¢ Envelopes with self-stick adhesives may cause wrinkling,
creasing, or even jams and may even damage your
product.

e Fan stacks of labels or transparencies before loading them
into the paper bin. If jams occur, try feeding one sheet at a
time.

¢ Do not load wrinkled, creased, damp, or highly curled
paper.

¢ Do not mix paper sizes in the paper bin.
¢ Use only recommended print media.

e Make sure that the recommended print side is facing up
when loading it in the paper bin.

e Keep print media stored in a suitable environment.

TROUBLESHOOTING m
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Display

ADD PAPER THEN
PRESS ENTER

LCD Error Messages

Solution

Meaning

Paper has run out while
printing.

CHANGE BLACK
INK

The black ink cartridge
has run out.

CHANGE COLOR
INK

The colour ink cartridge
has run out.

CHANGE PHOTO
INK

The photo ink cartridge
has run out.

CHECK The print cartridges are

CARTRIDGES not installed or have
some problem.

CHECK LEFT The colour cartridge is

CARTRIDGE not installed or has some

problem.

CHECK RIGHT
CARTRIDGE

The black (or photo)
cartridge is not installed
or has some problem.

CID NUM. EMPTY

You have attempted to
register a junk fax
number when the CID
list is empty.

DOCUMENT JAM

The loaded document
has jammed in the
feeder.

LINE ERROR

Your unit cannot connect
with the remote
machine, or has lost
contact because of a
problem on the phone
line.
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Display Meaning Solution

LOAD DOCUMENT  You have attempted to
set up a sending
operation with no
document loaded.

MEMORY FULL The memory is full.

MEMORY JOB You attempted to add
NOT ASSIGNED documents when there is
no scheduled job.

NO ANSWER The remote machine has
not answered after all
the redial attempts.

NO. NOT The one-touch or speed

ASSIGNED dial location you tried to
use has no number
assigned to it.

PC NOT Your product is not
AVAILABLE properly connected to
your PC.

POLLING ERROR The remote fax machine
you want to poll is not
ready to respond to your
poll.

Or

When setting up to poll
another fax machine,
you have used an
incorrect poll code.

TROUBLESHOOTING
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Display
RECEIVE ERROR

Meaning

A fax has not been
received
successfully.

REMOVE PAPER
JAM AND PRESS
CANCEL

Recording paper has
jammed.

RETRY REDIAL?

The product is waiting
for a specified time
interval to redial a
station which was busy
or did not answer

previously.
SEND ERROR Your fax has not gone
through successfully.
TX NOT You have attempted to
AVAILABLE send a document while
the product is printing
received data.
WRONG PIN You have entered the
CODE wrong PIN Code.

Solution
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Fixing Problems

Fax Problems

Symptom Cause and Solution

The product is not
working, there is no
display and the buttons
are not working.

¢ Unplug the power cord and plug it in again.
e Check that your socket is active.

No dial tone.

o Check that the phone line is connected
properly.

¢ Check the phone socket on the wall by plugging
in another phone.

The numbers stored in the
memory do not dial
correctly.

¢ Make sure that the numbers are stored in the
memory correctly.

¢ Print a Phonebook list. See page 5.36.

The document does not
feed into the product.

¢ Make sure that the document is not wrinkled
and you are putting it in correctly. Check the
document is the right size, not too thick or thin.

¢ Make sure that the cover is firmly closed.

You cannot receive faxes
automatically.

e The FAX mode should be selected.
e Is there paper in the product?
¢ Check if the display shows *"MEMORY FULL".

Your product cannot
receive faxes manually.

¢ Did you hang up the handset before you
pressed Start FAX Black or Start FAX
Color?

Your product will not send
anything.

e Make sure that the document is loaded face
down.

¢ “TX"” should show up on the display.

¢ Check the other fax machine you are sending
to, to see if it can receive your fax.

You cannot poll another
fax machine.

¢ The product you are polling may be using a poll
code.

TROUBLESHOOTING m
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Symptom Cause and Solution

The incoming fax has
blank spaces or you
received a poor-quality
copy.

¢ The product sending you the fax may be faulty.

¢ The remote fax machine sending you a fax may
have a dirty scan glass.

¢ A noisy phone line can cause line errors.
o Check your product by making a copy.
¢ The print cartridge may be empty.

Are some of the words on
the incoming fax
stretched?

¢ The fax machine sending you the fax had a
temporary document jam.

There are lines on the
copies or documents you
send.

o Check your scan glass for marks, and clean it.
See page 6.21.

The product dials a
number, but fails to make
a connection with another
fax machine.

o The other fax machine may be turned off, out
of paper, or cannot answer incoming calls.
Speak with the other machine operator and ask
them to sort out the problem.

You cannot store a
document in the memory.

¢ There may not be enough memory to store the
document. If the display shows a ‘MEMORY
FULL message, delete any documents you no
longer need from the memory, and restore the
document.

Blank areas appear at the
bottom of each page or on
other pages, with only a
small strip of text printed
at the top.

¢ You may have chosen the wrong paper settings
in the user option setting. See page 5.39 to
choose a proper paper size.

Download from Www.Somanuals.com. All Manuals Search And Download.




Paper Feeding Problems

Symptom Cause and Solution

Paper is jammed Clear the paper jam. See page 7.2.
during printing.

Paper sticks together. ¢ Ensure there is not too much paper in the paper
bin. Depending on the thickness of your paper, the
paper bin can hold up to 100 sheets of paper.

e Make sure you are using the correct type of paper.
See “Paper Selection” on page 2.2.

e Remove paper from the paper bin and flex or fan
the paper.

¢ Humid conditions may cause some paper to stick
together.

Paper fails to feed. Remove any obstructions inside the product.

Multiple sheets of o Different types of paper may be stacked in the
paper do not feed. paper bin. Load the paper of only one type, size,
and weight.

e When loading paper, do not force the paper down
into the printer.

o If multiple sheets have caused a paper jam, clear
the paper jam. See page 7.2.

Paper skews or buckles e Ensure there is not too much paper in the paper
bin. Depending on the thickness of your paper, the
paper bin can hold up to 100 sheets of paper.

¢ Make sure the paper guide does not cause the
paper to bow in the paper bin.

¢ Make sure you are using the correct type of paper.
See “Paper Selection” on page 2.2.

¢ When loading paper, do not force the paper down
into the product.

e Make sure the right side of the paper is aligned
with the right edge of the paper bin, and the left
paper guide is set against the left side of the paper.

Transparencies stick Use only the transparencies specially designed for an
together in the paper ink jet printer. Remove each transparency as it exits
exit. from the printer.

TROUBLESHOOTING E
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Symptom Cause and Solution

Envelopes skew or fail Ensure that the paper guide is against the left side of
to feed correctly. the envelopes.

General Printing Problems

Problem Possible Cause and Remedy

Your product ¢ The printer cable is not connected properly. Check the
does not print. printer cable connection.

¢ The printer cable is defective. Swap the cable with one
known to work.

¢ The port setting is incorrect. Check the Windows printer
settings to make sure that the print job is being sent to
the correct port (for example, LPT1).

¢ You have unplugged the USB cable from your computer

then plugged back to a different USB port than you have

used before. In this case, your printer driver creates a

virtual printer in the Printer folder on your computer

system each time you use another different port. You

have to remove the newly created virtual printer(s). To

remove:

1. Open the Printer folder and right-click on the last
created Samsung SF-430 Series Copy x (where
X is the number of the created virtual printers).

2. Select Properties from the pop-up menu and then
click Ports tab.

3. Locate the USB port which is checked and then close
the Printer folder.

4. Reopen the Printer folder.

5. Right-click on the original printer Samsung SF-430
Series.

6. Select Properties from the pop-up menu and then
click Ports tab.

7. Put a check mark in the checkbox of the USB port you
have found at step 3.

8. Remove Samsung SF-430 Series Copy x from
the Printer folder.

m TROUBLESHOOTING
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Problem Possible Cause and Remedy

Your product ¢ The print cartridge is not installed properly. Remove and

does not print. reinsert the print cartridge.

(continued) » The printer properties may be configured incorrectly.

Check the application to make sure that all print settings
are correct.

e The printer driver may be incorrectly installed. Uninstall
the MFP driver and reinstall the MFP driver. Then try
printing a test page. Refer to “Uninstalling Samsung
Software” on page See “Uninstalling Samsung Software”
on page 1.29.

¢ A paper jam has occurred. Remove the jammed paper.
See page 7.2.

e For Windows 2000/XP, if you remove the product from
the PC and then connect back to the PC, the printer
might be set to Off line status. Open the Windows Printer
folder and check if the SF-430 is off line. If so, right-click
on SF-430 Series printer and deselect Use Printer

Offline.
A file sent from e From the Acrobat Reader File menu, Select Print and
Acrobat Reader check the Print as image box. If it does not solve the
4.0 does not problem, upgrade Acrobat Reader to 5.0 or higher.
print or print
properly.
The paper is not ¢ Paper has not been inserted correctly. Remove and
fed into the reinsert the paper correctly. See “Loading Paper” on
product. page 1.11.

e There is too much paper in the paper bin. Remove some
of the paper from the paper bin.

The paper keeps o There is too many sheets of paper in the paper bin.
jamming. Remove some of the paper from the bin. (If printing onto
transparencies, or labels, insert them one at a time.)

¢ The paper setting method may be incorrect. If printing
onto envelopes, insert the envelopes to have a gap of
approximately 1 mm (1/32") between the left and right
edge of the envelopes at the paper guide.

TROUBLESHOOTING E

Download from Www.Somanuals.com. All Manuals Search And Download.



Problem Possible Cause and Remedy

Part of the
printed page is
blank.

¢ The page layout is too complex. Simplify the page layout
and remove any unnecessary graphics from the
document if possible.

¢ The page orientation setting may be incorrect. Change
the page orientation in the Printer Properties dialogue
box.

¢ The paper size and the software paper size settings do
not match. Insert the correct paper into the product or
change the software paper size settings.

e If using a parallel cable, ensure that it is compliant with
an IEEE-1284 rated cable.

Your product
prints the wrong
data, or it prints
incorrect
characters.

¢ The printer cable might not be connected properly.
Check the printer cable connection.

e There may be a problem with the printer driver software.
Exit Windows and reboot the computer. Turn the printer
off and then back on again.

o If using a parallel cable, ensure that it is compliant with
an IEEE-1284 rated cable.

Printing is too
slow.

¢ You may be using High or Maximum print quality. See
page 2.11. The higher the quality, the lower the speed.

o If you are using Windows NT, the Scheduling setting may
be set incorrectly. From the Start menu, select Settings
and Printers. Click your printer icon with the right
mouse button, select Properties, click the Scheduling
tab. Then, select the desired scheduling setting from the
available choices.

When printing
using the USB
connection, an
error occurs
repeatedly

When the USB mode is set to FAST, the communication

between the product and the computer may be poor.

Change the USB mode to SLOW. To do so, take the

following steps:

1. Press Setup on the front panel. You can see “"1.SYSTEM
SETUP” on the display.

2. Press Enter.

3. Press the Scroll buttons (< or ») until you see
“USB MODE” and then press Enter.

4. Press the Scroll buttons (<« or ») to select "SLOW”
and then press Enter to save the selection.
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Colour Printing Problems

Problem Possible Cause and Remedy

Your product prints e The Samsung SF-430 Series printer driver may not
only in black be selected. Verify that you selected the Samsung
SF-430 Series printer driver.

e The colour print cartridge may not be working
properly. Print a test page to make sure the ink
cartridges are working correctly.

¢ The print nozzles of the colour print cartridge may
need to be cleaned. Clean the print cartridges. See
page 6.3.

¢ You may be using Black Only in your printer
driver. See page 2.11.

Colours print e The Samsung SF-430 Series printer driver may not
incorrectly be selected. Verify that you selected the Samsung
SF-430 Series printer driver.

e Print cartridges may be installed in the incorrect
holders. Remove each print cartridge that is in an
incorrect holder. Check that the ink have not mixed
in the cartridges. If this is the case, replace the
cartridge with a new one.

e Print a test page. If the problem persists, replace
the cartridge with new one.

e Print nozzles on the colour print head may be
clogged. Print a test page to check the status of the
nozzles and clean the print cartridge. See page
6.3.

Colours are missing ¢ The colour print cartridge may not be working
properly. Print a test page to make sure the ink
cartridge is working correctly.

¢ The print head may need to be cleaned. Clean the
print cartridges. See page 6.3.

Colours in a line are ¢ You may have turned the product off(paused) and
uneven, or different then on(resumed) during print job. Do not turn the
from the previous lines product off and back on during a print job.

e Set the print quality to High or Maximum in the
printer driver.

e Align the print cartridges. See page 6.16.

TROUBLESHOOTING E
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Problem Possible Cause and Remedy

Hue changes e Print nozzles on the print head may be clogged.
Print a test page to check the status of the nozzles
and clean the print cartridge. See page 6.3.

¢ The colour print cartridge may be empty. Replace
the cartridge with a new one. See page 6.10.

Print Quality Problems

Problem Possible Cause and Remedy

Light print or fade e The print cartridge may be running out of ink. Install a
new ink cartridge.

e The paper may not meet paper specifications (for
example, the paper is too moist or too rough). See
“Paper Selection” on page 2.2.

o If the whole page is light, the print resolution setting is
too low. Adjust the print resolution within the printer
properties. See page 2.11.

¢ A combination of faded and smeared defects may
indicate that the print cartridges need to be cleaned.
See “Cleaning the Print Cartridges” on page 6.3.

Splashed dots ¢ The paper may not meet paper specifications (for
example, the paper is too moist or too rough). See
“Paper Selection” on page 2.2.

e The print nozzles may be clogged with ink. See
“Cleaning the Print Cartridges” on page 6.3.

White streaks or ¢ The moisture content of the paper is uneven or the
missing dots paper has moist spots on its surface. Try a different
kind or brand of paper.

e Print cartridges may be installed incorrectly. Make sure
the print cartridges are installed correctly.

e A print cartridge may be empty. Check the contacts of
the print cartridge. If there is not any ink in the
cartridge, replace it with a new one.

¢ The print media being used may not be acceptable. Use
only print media specified in “Paper Selection” on page
2.2.

¢ The print head may be aligned incorrectly. Print the
alignment pattern to align the print cartridge. See page
6.16.

m TROUBLESHOOTING
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Problem Possible Cause and Remedy

Blurred or ¢ You may printing on the wrong side of the paper. Turn
smudged ink the paper over and print on the other side.

¢ The paper may not meet paper specifications (for
example, too moist or too rough). See “Paper Selection”
on page 2.2.

e Let the ink dry before handling the paper.

Characters with ¢ The print cartridge may be almost empty. Check the
white lines contacts of the print cartridge and replace, if necessary.

e The print cartridges may need to be cleaned. See
“Cleaning the Print Cartridges” on page 6.3.

Characters are ¢ The print media is loaded incorrectly or is an
improperly formed unsupported size or type. Use the print media specified
or not aligned in “Paper Selection” on page 2.2.

correctly

o If characters are improperly formed, producing a wavy
effect, the scanner unit may need servicing.

e The print cartridges may need to be cleaned. See
“Cleaning the Print Cartridges” on page 6.3.

¢ The print cartridges may need to be aligned. See
“Aligning the Print Cartridges” on page 6.16.

Vertical lines in ¢ The print cartridge may need to be cleaned. See
tables, borders “Cleaning the Print Cartridges” on page 6.3.

and graphics not e print cartridge may need to be aligned. See
smooth

“Aligning the Print Cartridges” on page 6.16.

Solid black areas ¢ Change the fill pattern in the application software.
contain white

streaks
Printing appears ¢ The print resolution selected in the printer driver may
jagged be low. Check the printer driver for the correct

resolution. Printing in low resolution will give the
printout a jagged look. Change the Print Quality to a
higher resolution. See page 2.11.

TROUBLESHOOTING m
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Scanning Problems

Problem Possible Cause and Remedy

The product does not ¢ Make sure you place the document to be scanned
scan. face down on the document glass.

¢ There may not be enough available memory to
hold the document you want to scan. Try the Pre-
Scan function to see if that works. Try lowering the
scan resolution rate.

¢ The USB or parallel cable is not connected properly.

e The USB or parallel cable is defective. Swap the
cable with a known good cable. If necessary,
replace the cable.

e If using a parallel cable, ensure that it is compliant
with the IEEE 1284 standard.

¢ The scanner is configured incorrectly. Check scan
setting in the SmarThru Configuration or the
application you want to use to make certain that
the scanner job is being sent to the correct port
(for example, LPT1).

The unit scans very ¢ Check if the product is printing received data. Scan
slowly. the document after the current job is completed.

e Graphics are scanned more slowly than text.

e Communication speed becomes slow in scan mode
because of the large amount of memory required
to analyse and reproduce the scanned image. Set
your computer to ECP printer mode through BIOS
setting. It will help to increase the speed. For
details on how to set BIOS, refer to your PC
documentation.

The following message  There may be a copying or printing job in progress.
appears on the When the current job is completed, try the job again.
computer screen:

Scanner is busy

receiving or printing

data. When the current

job is completed, try

again.

Download from Www.Somanuals.com. All Manuals Search And Download.



APPENDIX

This chapter includes:

o Printer Specification

e Scanner and Copier Specification
e Fax Specification

e General Specification

e Paper Specification
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Printer Specification

Item | Description
Emulation HBP (GDI)
Resolution True 600 x 600 dpi, 2400 x 1200 dpi
Printing speed 14 PPM (mono)

7 PPM (colour)

Effective printing width 203 * 1 mm (8 inches)

Scanner and Copier Specification

Item | Description
Scanning method CIS, Sheetfeed
Scan resolution 600 x 1200 dpi
Scan mode True colour, 256 grey, Black and white
Copy mode Colour, Black and white
Effective scanning width 210 mm

Maximum document width 216 mm

Multi copy range 1~99

Reduction & Enlargement 25% ~ 400% in 1% increment

Maximum print edge margin Top: max 4mm
Bottom: max 5 mm

* Print Quality Guarantee margin
Colour: 19.05 mm
mono: 12.7 mm

Each side: 3.5 mm * 2 mm (A4)
6.5 mm * 2 mm (LTR)
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Fax Specification

Item | Description
Applicable line G3 PSTN (Public Switched Telephone
Network)
Compatibility ITU Group 3
Resolution Mono Standard: 203 x 98 dpi
Fine: 203 x 196 dpi
Super Fine: 300 x 300 dpi
Colour 200 x 200 dpi (High compression)
200 x 200 dpi (Middle compression)
200 x 200 dpi (Low compression)
Data coding MH/MR/MMR/IPEG
Maximum modem speed 33.6 kbps
Transmission speed 3 sec. (Standard resolution, MMR, 33.6 kbps)
Memory 2 Mbytes
Effective scanning width 210 mm

Effective printing width

203 mm * 1 mm (8 inches)

Document width and weight

176 ~ 216 mm, 16 Ib ~ 24 Ib

ADF capacity

30 pages (20 Ib)

APPENDIX m
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General Specification

Item

Paper bin capacity

Description
100 sheets (20 Ib)

Paper output tray capacity

50 sheets (20 Ib)

Printer/Scanner average life
time (approximate)

20,000 pages

ADF Rubber life time
(approximate)

10,000 pages

Operating Environment

Temperature: 10-32 °C (20 ~ 80% RH)

Original document width
and weight

176 ~ 216 mm, 16 Ib ~ 24 Ib

Power rating

See Rating Label attached on the back of the
machine.

Power consumption

15 W in Standby mode
20 W during operation

Weight

5.6 kg (without cartridges)

Dimensions (WxDxH)

With the paper support and output tray
retracted: 439.8 x 326.6 x 192.9 mm

With the paper support and output tray
extended: 439.8 x 602.5 x 192.9 mm

Ink Cartridge Life
(approximate)

Black Cartridge High yield: 1,100 sheets

Standard: 600 sheets
(based on ITU 5% chart - see "A Sample of ITU
5% Chart (reduced to 60%)” on page 8.6.)

Colour Cartridge High yield: 625 sheets

Standard: 275 sheets
(based on ITU 15% chart)

Photo Cartridge: 450 sheets
(based on ITU 15% chart)
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Paper Specification

Item | Description

Paper types Plain paper, OHP film, Label, Envelope, Card,

available Postcard

Paper sizes

Paper Type W x L (mm) W x L (Inch)
Letter 215.9 x 279 8.5x11
Legal 215.9 x 355.6 8.5X 14
JIS B5 182 x 257 7.17 x 10.12
A4 210x 297 8.27 x 11.69
Executive 184.2 x 266.7 7.25x 10.5
A5 148.5 x 210 5.85 x 8.27
A6 card 105 x 148.5 4.13 x 5.85
Post Card 4x6 101.6 x 152.4 4x6
HagaKi 100 x 148 3.94 x 5.83
Envelope 7-3/4 98.4 x 190.5 3.88x 7.5
Envelope COM-10 105 x 241 4.12x9.5
Envelope DL 110 x 220 4.33 x 8.66
Envelope C5 162 x 229 6.38 x 9.02
Custom 76 ~ 216 x 2.99 ~ 8.5 x
127 ~ 432 5~17
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A Sample of ITU 5% Chart (reduced to 60%)

THE SLEREXE COMPANY LIMITED

SAPORS LANE - BOOLE - DORSET - BH25 8ER
TELEFHONE BOOLE (945 13) 51617 - TeLEx 123456

Our Ref. 350/PJC/EAC 18th January, 1972.

Dr. P.N. Cundall,
Mining Surveys Ltd.,
Holroyd Road,
Reading,

Berks.

Dear Pete,

Permit me to introduce you to the facility of facsimile
transmission.

In facsimile a photocell is caused to perform a raster scan over
the subject copy. The variations of print density on the document
cause the photocell to generate an analogous electrical wvideo signal.
This signal is used to modulate a carrier, which is transmitted to a
remote destination over a radio or cable communications link.

At the remote terminal, demodulation reconstructs the video
signal, which is used to modulate the density of print produced by a
printing device. This device is scanning in a raster scan synchronised
with that at the transmitting terminal. As a result, a facsimile
copy of the subject document is produced.

Probably you have uses for this facility in your organisation.

Yours sincerely,

17
P.J. CROSS
Group Leader - Facsimile Research

Registered in England: Mo, 2088
Ragistered Office: 60 Vienrn  Lane, [iford. Essex.
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Replacing the Fitted Plug (UK)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug
and has a 13 amp fuse. When you change or examine the fuse, you must re-fit
the correct 13 amp fuse. You then need to replace the fuse cover. If you have
lost the fuse cover, do not use the plug until you have another fuse cover. Please
contact the people from you purchased the machine.

The 13 amp plug is the most widely used type in the UK and should be suitable.
However, some buildings (mainly old ones) do not have normal 13 amp plug
sockets. You need to buy a suitable plug adaptor. Do not remove the moulded

plug.
Warning

If you cut off the moulded plug, get rid of it straight away.
You cannot rewire the plug and you may receive an electric shock if you plug it
into a socket.

Important warning: You must earth this machine
The wires in the mains lead have the following colour code:

¢ Green and Yellow: Earth

e Blue: Neutral

e Brown: Live

If the wires in the mains lead do not match the colours marked in your plug, do
the following:

You must connect the green and yellow wire to the pin marked by the letter 'E’,
or by the safety ‘Earth symbol’ or coloured green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter ‘N’ or
coloured black.

You must connect the brown wire to the pin which is marked with the letter ‘L’
or coloured red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.
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Notes For Use of This Device (New Zealand)

The grant of a Telepermit for any item of terminal equipment indicates only that
Telecom has accepted that the item complies with minimum conditions for
connection to its network. It indicates no endorsement of the product by
Telecom, nor does it provide any sort of warranty. Above all, it provides no
assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model, nor does it imply that
any product is compatible with all of Telecom’s network services.

This equipment shall not be set up to make automatic calls to the Telecom '111’
Emergency Service.

This equipment may not provide for the effective hand-over of a call to another
device connected to the same line.

Important Notice

Under power failure conditions, this telephone may not operate. Please ensure
that a separate telephone, not dependent on local power, is available for
emergency use.

o3 APPENDIX
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Declaration of Conformity (European Countries)

Approvals and Certifications

g

The CE marking applied to this product symbolises Samsung Electronics Co.,
Ltd. Declaration of Conformity with the following applicable 93/68/EEC
Directives of the European Union as of the dates indicated:

January 1, 1995: Council Directive 73/23/EEC Approximation of the laws of
the member states related to low voltage equipment.

January 1, 1996: Council Directive 89/336/EEC (92/31/EEC), approximation
of the laws of the Member States related to electromagnetic compatibility.

March 9, 1999: Council Directive 1999/5/EC on radio equipment and
telecommunications terminal equipment and the mutual recognition of their
conformity.

A full declaration, defining the relevant Directives and referenced standards can
be obtained from your Samsung Electronics Co., Ltd. representative.

EC Certification

Certification to 1999/5/EC Radio Equipment &
Telecommunications Terminal Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European
single terminal connection to the analogue public switched telephone network
(PSTN) in accordance with Directive 1999/5/EC. The product has been
designed to work with the national PSTNs and compatible PBXs of the European
countries:

In the event of problems, you should contact the Euro QA Lab of Samsung
Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21 and/or TBR 38. To assist in the use
and application of terminal equipment which complies with this standard, the
European Telecommunication Standards Institute (ETSI) has issued an
advisory document (EG 201 121) which contains notes and additional
requirements to ensure network compatibility of TBR21 terminals. The product
has been designed against, and is fully compliant with, all of the relevant
advisory notes contained in this document.
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_______ |
A
Add documents..........cocevinenns 5.34
Align, print cartridge ............. 6.16
from SF-430..........cevvene. 6.16
from the computer........... 6.17
Automatic dial
o] o]0 ] o TN 5.25
one-touch .........cvevvinenen, 5.22
speed ....cocviiiiiiiiiiiiie 5.23
B
Booklet, print ...........ccvivinnenn 2.12
Broadcasting ..........coveeiininnen, 5.28
C
Cancel
faX o 5.8
PNt . . 2.7
501 4.5
scheduled fax .................. 5.35
Character, enter ................... 1.38
Clean
cartridge holder contact ..... 6.9
document scanner............ 6.21
print cartridge .................. 6.3
print nozzle ....................l. 6.6
Clean, print cartridge ............. 6.3
from SF-430........cccvivennnnn 6.4
from the computer ............ 6.5
Clearing......ccoevvviiiiiiiieens 7.2
Clock mode, change.............. 1.36
Collate
[o{0] 0 )V 3.8
Print....ccvi 2.10
Contents.....covvivviiiiiiiiiieeene 1.3
Contrast
[o{0] 0 )V 3.6
faX ciiii 5.4
PNt .. 2.14
Control program ................... 2.18
Copy page

{e] g /o] o)V A 3.7

for print......ccovviviiiiennnn, 2.10
Copying a document ............... 3.4
D
Date and time, set................ 1.34
Date format, change ............. 1.36
Default setting

[o/0] 0 )V 3.9

faX i 5.5
Delayed faX......coovvieivininnnnnn, 5.29
Dialling mode, set................. 1.42
Discard size, set........covvvuneen. 1.40
Document

set for Copy...ovvvvviiiiiinnnnn. 3.5

set for faX....ooovvvvivviiiinnnnn, 5.3

set for print...........ceeis 2.11
Document jam, clear............... 7.2
DRPD mode

receiving faxes ................ 5.19

Set Up. v 5.41
E
Error messages ...........covivennn 7.6
F
Fax and Internet gate............ 1.25
Fax number and name, set..... 1.37
Fax Settings Utility................ 5.44
Fax setup options ................. 5.38

from the computer........... 5.45
Faxing a document

FEVEIVE .t eneeenes 5.14

1=] o Lo [ 5.2
Forwarding fax ..........c.coeenens 5.20
Front panel

buttons........ccvviiiiiii, 1.6

location ......ocvvvvviiiiiiiennnn 1.4
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G

Guide
document...........ocuene. 3.4,5.6
PAPEL 1ttt 1.12
H
Handout, print..............oooeaie. 2.13
I
Ink level, view
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